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はじめに  

 

  この『Cogent DataHub® 入門ガイド』は、カナダのCogent Real-Time Systems社の 

リアルタイムデータソリューションである Cogent Datahub® の日本語ガイドブックです。 

 

 はじめて Cogent Datahub® をご使用される方に対し、評価用ソフトウェアのインストール

からCogent DataHub® 機能の設定方法、Web上のHMIの作成方法 までをなるべく判り 

やすく、知っていると今後のシステム構築に役立つ内容をピックアップして記載いたしました。 

 さらに詳しく知りたい方のために、英文マニュアルやビデオのリンクを添付いたしました。 

ビデオは英文ですが、詳しい設定方法や便利な使い方が紹介されています。 

是非、両方合わせてご使用ください。 

 

 このガイドブックは、Cogent Real-Time Systemsのパートナー企業である 

株式会社日新システムズ様、東亜無線電機株式会社様、株式会社ベルチャイルド様 のご協力 

のもと作成いたしました。 

このガイドブック作成に関わってくださっている全ての方々に心より深謝申し上げます。 

 

 全ての仕様、取り扱い方法は Cogent Real-Time Systems 社により開示されている情報（英

文）が本書に優先されます。 

 資料は、巻末の付録「資料情報」にURLを記載しております。 

 

 

2015年2月 

Cogent DataHub Application Center 

                             info@datahub-ac.com 

 

 

  

mailto:info@datahub-ac.com
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第 1 章 

Cogent DataHub®評価版 

ス タ ー ト ア ッ プ ガ イ ド     

   

 

    インストールからご使用方法まで、Cogent DataHub 評価版をすぐにご利用いただくため 

  のスタートアップガイドです。 
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Cogent DataHub インストールから起動まで 

 

１．Cogent DataHub の実行環境の準備 

Cogent DataHub v8.x.x（2019 年 1 月現在）をインストールする前に必要な環境は次の通りです。 

 DataHub システム要件  

    Cogent DataHubのシステム要件は、下記リンク先にてご確認いただけます。 

     https://cogentdatahub.com/download/technical-specifications/installation-notes/ 

 WebView システム要件 

     WebViewのシステム要件は、下記リンク先にてご確認いただけます。 

     https://cogentdatahub.com/docs/#wv-introduction.html#wv-systemrequirements 

 Windows PC 

動作環境としては、Windows XP SP2 以降の PC が必要です。64bit 版へもインストールが可

能です。 

Silverlight を使用したグラフィック表示機能である WebView を利用する場合には、ハードウ

ェア性能が画面表示速度に影響を与えますので、Ultra Mobile PC（いわゆるネットブック）で

はなく、Windows Vista 以降の Aero に対応できる程度のグラフィック・アダプタを備えた PC

を推奨します。 

 Microsoft .NET Framework 2 以降 （Windows XP 環境のみ必要）  

事前インストール 

Windows Vista 以降の環境であれば .NET Framework の事前インストールは不要です。 

Windows XP SP2 以降の環境では、インストール前に最新の .NET Framework 4.0 を以下の

リンクから入手して事前インストールしておくことが可能です。 

https://www.microsoft.com/ja-jp/download/details.aspx?id=17851  

 

http://www.cogentdatahub.com/jp/
https://cogentdatahub.com/download/technical-specifications/installation-notes/
https://cogentdatahub.com/docs/%23wv-introduction.html%23wv-systemrequirements
https://www.microsoft.com/ja-jp/download/details.aspx?id=17851
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オンライン・インストール  

事前インストールをしない場合でも .NET Framework のインストールが必要な Windows XP

へのインストール時には、次項のインストール手順に従ってインストール開始後、使用ライセン

ス確認後に以下の画面が表示されます。 

インターネットに接続している場合には、このメニューで「32-bit systems」か「64-bit 

systems」かの OS アーキテクチャを選択して、動作に必要な Microsoft .NET Framework 2

のオンライン・インストールを開始することが可能です。SET UP を実行すると下記画面が表示

されます。 

SETUP を実行すると下記の画面が表示されます。 

 

 

 

 

 

 

 

.NET Framework 2 のオンライン・インストールを行う場合は、最初に OS アーキテクチャを

選択すると次のようにダイアログで 2 回警告が出ますので、いずれも「実行」をクリックしま

す。 

     

 

 

 



Cogent DataHub® 入門ガイド 

    

S021601-001-120 2019/1/6   8  

その後 .NET Framework 2 のセットアップ開始画面が開きますので「次へ」をクリックして

インストールします。 

 

 

 

 

 

 

.NET Framework 2 のセットアップを完了画面で確認後、OS アーキテクチャの選択が表示さ

れたままですので「Cancel」をクリックして一旦このダイアログを閉じます。 

「Cancel」クリック後「Are you sure you want to quit Cogent DataHub Setup?」のダイア

ログが表示されるので、「はい」をクリックして終了後、再度インストール用実行ファイル 

(CogentDataHub-7.x.x-xxx-Windows.exe) を起動してインストールを開始します。 

 

 

 

   

 

正しく .NET Framework 2 がオンライン・インストールされていれば、DataHub のインスト

ールが自動的に先の画面に進みます。 
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 Silverlight 5  

事前インストール 

Silverlight 5 は WebView とセキュリティ管理機能で使用します。以下のリンク先から入手可

能です。インターネットに接続している環境であれば最初に Silverlight 機能を使用する時に、

オンライン・インストールが可能です。事前にインストールしておく場合には、以下のリンク先

にアクセスして入手・インストールが可能です。 

https://www.microsoft.com/silverlight  

オンライン・インストール  

インターネットに接続している環境では、事前インストールをしなくても WebView 起動時な

どの必要時に、Silverlight 5 のオンライン・インストールを行うことが可能です。オンライ

ン・インストール画面は、以下のようにブラウザで必要時に自動的に立ち上がるので、「今すぐ

クリックしてインストール」をクリックしてインストール開始が可能です。 

 

 

 

 

 

 

クリック後は次のようにダイアログで 2 回警告が出ますので、いずれも「実行」をクリックし

ます。 

 

 

 

https://www.microsoft.com/silverlight
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「Silverlight のインストール」ダイアログでは「今すぐインストール」をクリックして進みま

す。 

 

 

 

 

インストールが終了すると「インストールが正常に完了しました」のダイアログが表示されま

す。 
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２．Cogent DataHub のインストール 

Cogent DataHub 8.x.x-xxx（2019 年 1 月現在）を事例として、DataHub の最新版入手方法とイン

ストール方法を説明します。 

 入手先 （最新版） 

DataHub のソフトウェアは無償評価版として、Cogent 社のダウンロード・サイトにて、情報

を登録することで入手可能です。ダウンロードしたソフトウェアは製品版と同じものでありライ

センス・キーを別途購入し、購入したライセンス・キー入力することで、製品として利用可能に

なります。 

以下のリンク先から Cogent 社ホームページへアクセス可能です。 

    Cogent社 Cogent DataHub無償評価版ダウンロード・リクエスト・サイト 

      https://cogentdatahub.com/download  

 

 Cogent DataHub 無償評価版 入手手順 

    １．上記、Cogent DataHub無償評価版ダウンロード・リクエスト・サイトのフォーム 

      に情報を入力し、Send me the download link をクリックします。 

    ２．その後すぐに、Skkynet社よりダウンロード・サイトへのリンクがメールで届きます。 

    ３．メールに記載されているリンクにアクセスしてください。 

ダウンロード・メニューの一番上にある Cogent DataHub - 全バージョン を入手することで

DataHub の多彩な機能を Windows 上で試すことが可能です。 

実行ファイルは、CogentDataHub-x.x.x-xxx-Windows.exe という名前のファイルです。新

しいバージョンが出た場合には、ファイル名の x の部分が変更されます。 

もし、Skkynet 社からメールが届かない場合は、再度リクエスト・フォームからリクエストい

ただくか、最寄りの代理店もしくは下記へご連絡ください。 

  Cogent DataHub Application Center     ：info@datahub-ac.com 

    

https://cogentdatahub.com/download
file:///C:/Users/nic_yamaguchi/AppData/Roaming/Microsoft/Word/info@datahub-ac.com
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 インストール  

ダウンロードしたファイル「CogentDataHub-x.x.x-xxx-Windows.exe」を起動して、インス

トールを開始します。 

「Windows XP で .NET Framework 2 以降の事前インストールをしていない場合には、自動

的に前項の「Install .NET 2.0」ダイアログが表示されるので、OS アーキテクチャを選択し

て、インストールします。 

インストールを開始後、ライセンス確認の後でインストール先のディレクトリや、インストール

項目を確認する画面が表示されますが、全てを選択（デフォルト状態）してインストールするこ

とをお勧めします。 

 

 

   

 

 

 

 以下の様に３つのアイコンがデスクトップ上に表示されればインストールは完了です 
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３．Cogent DataHub の起動 

歯車型アイコンをダブルクリックして DataHub を起動します。 

 評価版の制約時間  

ライセンス・キーを入力しない場合、DataHub は評価版として動作します。 

評価版であっても、DataHub の全機能を 1 時間、継続して使用することが可能です。 

DataHub の起動後 1 時間立つと、「Expired」（時間切れの警告メッセージ）が表示され、

Cogent DataHub が一旦終了します。しかし再起動することで、再び 1 時間ずつ継続して使用

可能です。 

 

 

 

 

DataHub 起動時は、起動画面とメッセージが重なり隠れておりますが、起動画面をクリックす

るか数秒待っていただくと起動画面が消え、メッセージを確認することが可能です。 

OK をクリックし、画面を閉じてください。 

 

 

 

 

 

DataHub を初めて起動する場合、PC 環境の設定によっては次のようなセキュリティ設定の確

認の警告が表示される場合があります。 

それぞれ「アクセスを許可する」または「ブロックを解除する」をクリックして、DataHub が

使用する通信ポートのブロックを解除します。ブロックを解除しないと、DataHub は通信を行

う事ができません。 
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 タスクトレイ  

DataHub は全ての機能が１つのメニュー・プログラムから呼び出すことが出来るようになって

いる、タスクトレイ常駐型のアプリケーションです。従って動作中であれば、メニューを閉じて

もタスクトレイの歯車アイコンを右クリックすることで、呼び出すことが可能です。 

 

メニュー・プログラムは 1 番上の「Cogent DataHub」を指定して起動します。右クリック・

メニューから呼び出し可能な他の機能は、それぞれの個別機能を呼び出す「ショートカット」と

なっています。 
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４．Cogent DataHub のメニュー画面 

以降は、Cogent DataHub の代表的な新機能である WebView を使用する方法を事例にして、

DataHub の使い方を記載します。 

 

2017 年 4 月より Cogent DataHub V8 がリリースされ、新しい機能として、「OPC UA」、「USB カメ

ラ」、「トンネル/ミラーによるフォワード・プロキシ対応」が追加されました。 

これらの新しい機能に関しては、『 Cogent DataHubⓇ V8 新機能ガイド 』をご参照ください。 

 

  

http://nic-jp.co.jp/CogentDataHub/Cogent_DataHub_v8_Guide.pdf
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Cogent DataHub WebView の使い方 

１．Cogent DataHub のメニュー画面 

Cogent DataHub のメニュー画面では次のような機能を利用可能です。以下に DataHub の主要機能

について簡単に解説します。 

 基本設定：起動画面の表示など、起動時の設定とデータ処理の設定を指定します。 

 OPC DA：OPC DA クライアント、サーバとしての動作を設定します。 

 OPC UA：OPC UA クライアント、サーバとしての動作を設定します。 

 OPC A&E：OPC クライアントのアラームとイベント通知機能を設定します。 

 トンネル / ミラー：DataHub 間をネットワークまたはインターネットを介して接続します。 

 ブリッジ：２つ以上のデータソースを接続してデータを共有します。 

 DDE：DDE (Excel や Word 文書中に動的データを埋め込む機能) のサーバ側とクライアン

ト側の設定を行います。 

 アグリゲージョン：複数のソースからのデータを共通のデータセットに集約します。 

 Quick Trend：Quick Trend (時間とともに変化する折れ線グラフ) を起動します。 

 WebView：Silverlight テクノロジーを使用した組み合わせ自在な、動的グラフィカル・デー

タ・表示機能を起動します。 

 Web サーバ：Web サーバの設定を行います。WebView やトンネル/ミラーで WebSocket を

使用する時に設定します。 

 データロギング：ODBC データベースへのデータの書き込み、読み込みを設定します。 

 ヒストリアン：高速かつ省リソースでのデータ保存機能を設定します。 

 Sys モニタ：稼働しているシステム(ローカル PC) から取得可能な各種情報を DataHub のデ

ータとして扱うための設定を行います。 

 E メール / SMS：設定条件による、E メール / SMS 通知機能を設定します。 

 Redundancy：システムの冗長性設定機能です。 

 カメラ：USB カメラに接続し、ライブビデオや画像を取得します。 

 Modbus：Modbus TCP スレーブへの接続を設定します。 

 スクリプト：標準機能のカスタマイズやデータ処理を追加します。 

 セキュリティ：アクセスを制御し個人ユーザやグループユーザ毎の異なる権限を設定します。 

 ライセンス：ライセンス購入時にライセンス設定を行います。  
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２．WebView の起動 

以降は WebView の使い方を示します。 

左側メニューの 8 番目にある「WebView」アイコンをクリックすると、以下の WebView の起動画面

が表示されます。最初は特に設定を変更する必要が無いので、そのまま「ブラウザ上で DataHub 

WebView 起動」をクリックして WebView を起動します。 
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３．ログイン画面 

少し待つと、WebView のログイン画面が表示されます。 

 

ブラウザの上部に「イントラネット設定は既定でオフになりました」という警告メッセージが出る場合

があります。これは DataHub が起動したマシン(localhost)上でサービスしている Web サーバにアク

セスしているためです。特に DataHub の実行には影響は無いので、警告メッセージを消しても構いま

せん。 

WebView は Microsoft 社の Silverlight 5 という技術を使ってグラフィック画面表示を行っていま

す。Silverlight 5 をインストールしていない環境で初めて WebView を起動した場合は、ログイン画面

では無く Silverlight 5 のインストール画面が表示されます。前頁の Silverlight 5 のオンライン・イ

ンストールの説明に従ってインストールを行って下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

もし、ログイン画面が表示されなかった場合は、Web サーバのポートが他のソフトウェアと重複してい

る可能性があります。９．Web サーバ の Web サーバポート変更方法を参考にポートを変更してみて

下さい。 
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 ログイン  

Username: [ admin ], Password:[ admin ]を入力後、「Connect」をクリックしてログイン

します。WebView のメインメニューが表示されるまで、数秒かかります。 
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４．スタート画面での設定 

ログインに成功すると以下の様なスタート・メニュー画面が開きます。 

以降は必要に応じて、Silverlight の使用可能な記憶域を増やす手順を説明します。  
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 警告メッセージ  

以下のように Isolated Storage の警告メッセージが出る場合には、「OK」をクリックして記

憶域を増やすことをお勧めします。 
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 記憶領域の増加  

以下に示すように、WebView 内画面の Tools メニューから 

「Approve Isolated Storage Incｒease...」を選択します。 
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 確認ダイアログ  

次のような確認のダイアログが表示されるので、「はい」をクリックして確認します。 
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５．ランモードとデモ用メニューの選択 

この状態ではまだ WebView のランモードで表示を行っていません。 

ランモードにするためには、 WebView 内画面の右向き緑色矢印をクリックします。  
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 ランモード  

以下にランモードの画面を示します。WebView 内画面の 赤色×印 をクリックすると元のデザ

インモードに戻ります。 

またこのスタートページのデモ画面自体が、14 種類ある WebView の各デモ画面を呼び出すメ

ニュー機能を持っているので、この画面で「Walter Treatment」などの各デモ名称が表示され

ているボタンをクリックすると、そのデモ画面に移動します。 
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 Water Treatment （水処理）デモ 

以下に Water Treatment デモ の画面を示します。この状態ではまだ DataHub が扱うべきデ

ータを受信していないので、デモの画面は動きません。 
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６．シミュレーション用データの起動 

 

デモでは、あらかじめ用意してあるシミュレーション用データを受信して画面を動作させることが可能

です。以下に「DataSim」と「DataPid」の 2 種類のテスト用データを発生させるプログラムを起動す

る手順を示します。  

 DataSim  

デスクトップの DataSim のアイコン（以下）から起動します。その下にランモードの画面を示

しますが、デモを実行する場合は特に設定する必要はありません。この DataSim が動作してい

る間、ローカルの DataHub にデモ用のランダムまたは周期的なデータが供給されます。 

 

 

 

 

 

 

 DataPid  

デスクトップの DataPid のアイコン（以下）から

起動します。その下にランモードの画面を示しますが、デモを実行する場合は特に設定する必要

はありません。この DataPid が動作している間、ローカルの DataHub にデモ用のランダムまた

は周期的なデータが供給されます。 
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７．他の動作デモ 

  デザインモード画面に戻って別のデモを選択することで、他の動作デモを試す事が可能です。  

 Page タブ  

デザインモードの右側ペインの Page タブをクリックすることで、他のデモの一覧を表示させる

ことが可能です。ここでは緑色の矢印をクリックするか、または Filename をダブルクリックし

て、直接目的のデモを実行することが可能です。 
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 Tank and piping example (Tank Level) 

以下は「Tank Level」をダブルクリックして、Tank and piping example のデモを実行した

様子です。 
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８．新しいページの作成（オブジェクト追加、データバインド） 

 １． あらかじめ「DataPid」 を起動しておいてください。 

 

 

 

 

 2． WebView を開き、「File」 → 「New」をクリックしてください。 

 

 

 

 

 

 3． 背景のみの新規ページになります。 
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 4． 追加したいオブジェクトを下段バーから選びます。 

    例として Circular Gauge 2 をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 5． 中央にゲージ図形が出現しますので、これをマウスでクリックします。 
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 6． 左プロパティ画面より、以下のように設定します。 

  Current Value ： 赤丸 内の   をクリックしますと、ドロップダウンして設定項目が 

  現れます。 

  Binding ：      をドロップダウンメニューから選びます。 

  一番下の空欄に DataPid:PID1.Pv を入力します。 

 

 

 

 

 

 

 

 

 

7． Current Value が DataPid シミュレーションによって変化し続けるようになり、ゲージの 

    針が動くようになります。 
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 8． File → Save As で作成したページを保存することが出来ます。 

 

 

 

 

 

 

 

 9． ここでは暫定的に Test1 として保存します。 
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 10． 保存したページを呼び出すには、左画面で Page タブを選択し、Users/admin の下の 

     Test 1 をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  以上で新しいページが作成されました。 
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第 2 章 

Cogent DataHub® 

M 2 M 設 定 ガ イ ド 

   

 

    Cogent DataHub® を用途に合わせてスムーズに設定していただく為の 

    『機能設定ガイド』です。 
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Cogent DataHub とは 

 

産業オートメーションのためのリアルタイムミドルウェア 

OPC UAおよびOPC Classic、クライアントとサーバへのリアルタイム双方向接続を可能とします。

ODBCデータベース、ModbusTCPスレーブ、Excelスプレッドシート、カスタムプログラム、Linuxシ

ステムおよび組み込みシステムを接続します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

すべてのデータを１つの統一されたデータセットに統合し管理します。 

全てのリソースや複数のプロトコルからのデータは統一されたデータセットに変換されます。 
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Cogent DataHub の機能とサービス 

Cogent DataHub では、産業システム構築に必要な様々な機能を選択可能な、お得なライセンスパッ

ケージと追加可能な Plug-In にて提供しております。 

 

DataHub ベース 

 ・Aggregation（アグリゲージョン） 

 ・QucikTrend 

 ・スクリプト 

 ・セキュリティ 

 ・ライセンス 

 

DataHub Plug-In 

 ・OPC UA 

 ・OPC DA 

 ・OPC A&E 

 ・トンネル/ミラー 

 ・ブリッジ 

 ・DDE 

 ・WebView 

 ・Webサーバ 

 ・データロギング : データベースへの 書き込み 読み取り 

 ・ヒストリアン 

 ・Sysモニタ（システムモニタ） 

 ・Eメール/SMS 

 ・Redundancy（リダンダンシー） 

 ・カメラ 

 ・Modbus 
 

 

その他 

 ・API（Application Programming Interface）：お客様アプリケーションのデータを Windows上

の Cogent DataHub や Linux上の Cascade DataHub へ統合するためのプログラミングイン

ターフェイスを提供しています。 

https://cogentdatahub.com/features/customize/datahub-apis  

 

 

https://cogentdatahub.com/features/integration/aggregation/
https://cogentdatahub.com/features/visualization/quicktrend/
https://cogentdatahub.com/features/customize/scripting/
https://cogentdatahub.com/features/utilities/security/
https://cogentdatahub.com/features/protocols/opc-ua/
https://cogentdatahub.com/features/protocols/opc-da/
https://cogentdatahub.com/features/protocols/opc-ae/
https://cogentdatahub.com/features/integration/tunnel-mirror/
https://cogentdatahub.com/features/integration/bridging/
https://cogentdatahub.com/features/protocols/dde-excel-support/
https://cogentdatahub.com/products/datahub-webview/
https://cogentdatahub.com/features/utilities/web-server/
https://cogentdatahub.com/features/integration/database-write/
https://cogentdatahub.com/features/integration/database-read/
https://cogentdatahub.com/features/utilities/historian/
https://cogentdatahub.com/features/utilities/system-monitor/
https://cogentdatahub.com/features/utilities/email-sms/
https://cogentdatahub.com/features/integration/redundancy/
https://cogentdatahub.com/features/visualization/camera/
https://cogentdatahub.com/features/protocols/modbus-driver/
https://cogentdatahub.com/features/customize/datahub-apis
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 ・Cascade DataHub ：Linuxシステムのライブデータにアクセスし、Windowsシステムへの 

データ統合を可能にします。 

https://cogentdatahub.com/features/remote-access/linux-connectivity  

 

 ・ETK（Embedded Toolkit）：組み込み機器のデータをCogent DataHubやSkkyHub、iBRESSへ 

   統合するための組み込み用通信ソフトウェアです。 

https://cogentdatahub.com/connect/embedded  

 

 ・SkkyHub、iBRESS：Cogent DataHubをベースに使用したセキュアなクラウドサービスです。 

   セキュアでリアルタイムな 遠隔地のデータ統合 と データのモニタリング などのサービスを 

提供する、IIoTのためのクラウドサービスです。Cogent DataHubやETKとシームレスに接続し 

ます。 

https://cogentdatahub.com/gas-monitoring-system  

 

 

https://cogentdatahub.com/features/remote-access/linux-connectivity
https://cogentdatahub.com/connect/embedded
https://cogentdatahub.com/gas-monitoring-system
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Cogent DataHub ライセンス 

Cogent DataHub のライセンスは、使用する機能に応じて価格が設定されています。以下の表に示す

ように、ライセンスパックおよびアドオン により購入が可能です。 

 

見積りを依頼する ことができます。Cogent社またはSkkynet社パートナーがお客様のニーズに合った

最適なライセンスの組み合わせをおすすめします。 

 

ライセンスパック 

製品名 含まれるDataHub機能 

Cogent DataHub 全てのCogent DataHub機能（カメラ機能は含まず） 

DataHub OPC Gateway OPC UA, OPC DA 

DataHub UA Tunneller OPC UA, OPC DA, トンネル/ミラー 

DataHub UA Bridge OPC UA, ブリッジ 

DataHub Modbus UA Server OPC UA, ModbusTCP 

DataHub UA WebView OPC UA, トンネル/ミラー, WebView, Webサーバ, ヒストリアン 

OPC UA DataHub 

 

OPC UA, トンネル/ミラー, ブリッジ, データロギング, 

DDE, システムモニタ，Email/SMS Notifications 

DataHub DA Tunneller OPC DA, トンネル/ミラー 

DataHub DA Logger OPC DA, データロギング 

DataHub DA Bridge OPC DA, ブリッジ 

DataHub Modbus DA Server OPC DA, ModbusTCP 

DataHub DA WebView OPC DA, トンネル/ミラー, WebView, Webサーバ, ヒストリアン 

OPC DA DataHub OPC DA, トンネル/ミラー, ブリッジ, データロギング, 

DDE, システムモニタ，Email/SMS Notifications 

DataHub DDE Tunneller DDE, トンネル/ミラー 

DataHub Modbus Tunneller ModbusTCP, トンネル/ミラー 

DataHub Modbus Logger ModbusTCP, データロギング 

DataHub System Monitor システムモニタ, トンネル/ミラー 

※上記ライセンスパックには、Aggregation、QuickTrend、スクリプト、セキュリティ が含まれます。 

 

アドオン ライセンス 

Tunnel/SkkyHub/TCP support トんネル/ミラー 

OPC DA support OPC DA（サーバ，クライアント） 

OPC UA support OPC UA（サーバ，クライアント） 

OPC A&E support OPC DA A&E（サーバ，クライアント） 

https://cogentdatahub.com/purchasing/
https://cogentdatahub.com/purchasing/request-a-quote/
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Modbus TCP ModbusTCP（マスタ） 

Data Bridging ブリッジ 

Data Logging データロギング（書き込み，読み取り） 

Excel/DDE support DDE（サーバ，クライアント） 

System Monitor システムモニタ 

Email/SMS Notifications Email/SMS 

Data Redundancy リダンダンシー 

Data Historian ヒストリアン 

DataHub Web Server Webサーバ 

DataHub WebView (Add-on) トンネル/ミラー, WebView, Webサーバ, ヒストリアン 

Camera support カメラ（カメラ機能は、アドオン ライセンスのみです。） 

 

コネクション ライセンス（Windows) 

TCP Link License x 1 Cogent DataHub API, ETK とのコネクション 

TCP Link License x 25 Cogent DataHub API, ETK とのコネクション 

 

コネクション ライセンス（Linux) 

Cascade DataHub (Linux) トンネル/ミラー(TCP/IP), Cascade DataHub API とのコネクション 

TCP Link License x 1 (Linux) Cogent DataHub API とのコネクション 
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Cogent DataHub の機能設定 

Cogent DataHub（以下DataHubと記載します）の機能は、各機能のプロパティを設定することで使用

可能になります。 

この『Cogent DataHub® M2M設定ガイド』では、各機能の設定方法を記載します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  適用：適用をクリックすると、変更を適用します。 

    DataHubの各機能設定を変更した場合は、必ず 適用 をクリックしてください。 

  OK：OKをクリックすると、変更を適用後画面が閉じられます。 

 

 キャンセル：キャンセルをクリックすると、変更を適用せず画面を閉じます。 

 

  機能のオプションを変更された後は、[OK] もしくは [適用] をクリックして下さい。 

  変更がDataHubに反映されます。 

 

 ヘルプ：ヘルプをクリックすると、マニュアルを見ることができます。 

 

  About：DataHubのバージョンを確認することができます。 
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 データブラウザ： 

  DataHubに接続しているデータが表示されます。 

  

 

 

 

 

 

 

 

 

  ポイント名を選択すると、選択ポイント にポイント名が表示され、新規値を入力 に値を入力 

  することで、選択ポイントの値を変更することが可能です。 

  選択ポイントの 品質 をリストボックスから選択することで変更することが可能です。 

  ※ライトが許可されたポイントのみ対応。 

 

 

 

 

 

 

 

 

 

 

 ドメインとは 

  DataHubは、接続データを階層構造で管理します。 

  ドメイン（データドメイン）とは、DataHubに接続されているデータ構造最上位の名称です。 

  必要な数のデータドメインを作成し、ユーザ、機能、または任意の基準でデータの識別に使用する 

  ことが可能です。 

 

    データドメイン：DataHubに接続されているデータ構造最上位の名称。 

    データポイント：データドメインでグループ分けされた識別データ名。 
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 接続情報： 

   すべてのDataHubへの接続をリアルタイムに表示します。 

 

 

 

 

 

 

 

 

 

 イベントログ： 

   DataHubのイベントログを確認することが可能です。 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   ファイルログ にチェックを入れ、ファイルを設定することで、ログを保存することが可能で 

      す。 
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 スクリプトログ：スクリプトログを確認することが可能です。  

 

 

 

 

 

 

 

 

 

 

 接続情報、イベントログ、スクリプトログ 不具合時にこれらの情報を確認することで、原因を特定 

 する手がかりになることがあります。 
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１．基本設定 

   

  

 DataHubから送信されるデータ変更の送信方法、DataHubの起動方法、有効データドメインを選択 

  します。 

 

 マニュアル：https://cogentdatahub.com/docs/#cdh-propertieswindow.html#cdh-propgeneral 

 （英文） 

 

基本設定 

  データ変更 

   同じ値で上書き禁止：タイムスタンプ以外（値もしくは品質）が変更された時のみデータを更新 

     します。ネットワーク帯域幅が問題になる場合は、このオプションを使用して、値が変更さ 

     れた時のみポイントを更新するようにします。 

   最新タイムスタンプ優先：現在のデータもしくは今後のデータのみを送信します。 

   タイムスタンプ自動付加：タイムスタンプがないデータにタイムスタンプを付加します。 

 

  起動 

   スプラッシュ画面を表示：DataHub起動時に起動画面を表示します。 

   デモ時間経過後、ワーニングを表示：評価版使用時に1時間経過メッセージを表示します。 

   自動起動：Widowsがログオンされる時にDataHubを起動します。 

   一つのプログラムのみ稼動許可：DataHubが同時に複数起動することを禁止します。 

 

  ドメイン選択：データドメインを追加、編集、削除することが可能です。 

    DataHubで有効 

 

 

 

 

 

   追加：データドメイン名を入力して、追加します。 

   編集：データドメイン名をダブルクリックまたは、クリックで選択し編集をクリックすること 

          で編集することが可能です。 

   削除：データドメインを削除します。 

https://cogentdatahub.com/docs/#cdh-propertieswindow.html
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   ドメイン自動追加：DataHubはクライアントから要求されたデータドメインを自動追加します。 

     もし、ドメインに制限を設けたい場合は、チェックしないで下さい。 

 

 インターフェース言語：DataHubが対応している言語 

   日本語、英語、中国語、スペイン語、ポルトガル語、ルーマニア語、デンマーク語 
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２．OPC-UA 

 

  

 概 要 

 OPC Unified Architecture（OPC UA）は、OPC Foundationの最新標準です。その目的は、Data 

Access（DA）、Alarms and Event（A＆E）、および Historical Data Access（HDA）のOPCクラ 

シック標準を単一の拡張可能なフレームワークに統一することです。同時に、OPC UAは、ネットワ 

ークサポートの強化、より洗練されたセキュリティモデル、プラットフォームの独立性、包括的な情 

報モデリングを提供します。 

 

 特 徴 

 ・OPC UAサーバーとクライアントプログラムの両方を同時に機能させることが可能です。 

 ・複数のOPC UAサーバーから読み取ることができ、このデータを任意の数のOPC UAクライアント 

  プログラムで使用可能です。 

 ・OPC UAサーバーとクライアントサポートは、他のDataHubの機能と完全に統合されています。 

 

 マニュアル：https://cogentdatahub.com/docs/#cdh-opcua.html （英文） 

 

 ビデオマニュアル： 

   Making an OPC UA client connection（英語）（7:43） 

   Making secure OPC UA connections（英語）（9:03） 

   Configuring DataHub UA server（英語）（3:37） 

 

インストールされる機能 

  Cogent DataHub をインストールすると、下記 OPC UA 機能がインストールされます。 

Name Description 

OPC UA プラグイン OPC UA サーバ、OPC UA クライアントに機能を有したプラグイ

ンです。 

Local Discovery Server OPC Foundation が無償で提供している OPC UA サーバの URL 

を管理するサーバーです。 

 

OPC Unified Architecture (UA)設定 

https://cogentdatahub.com/docs/#cdh-opcua.html
https://www.youtube.com/watch?v=1y_0x3ajFNI&feature=youtu.be&list=PL94JESkkGcmJpyxzHd5emYMyv3jpcFC2R
https://www.youtube.com/watch?v=n6N24wJsXcA&feature=youtu.be&list=PL94JESkkGcmJpyxzHd5emYMyv3jpcFC2R
https://www.youtube.com/watch?v=bQIvq5ZwhPs&feature=youtu.be&list=PL94JESkkGcmJpyxzHd5emYMyv3jpcFC2R
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  ここでは、DataHubをOPC UAサーバ、OPC UAクライアントまたは、同時に両方機能するように 

  設定する方法を記載します。 

 

OPC UA クライアント 

 

 

 

 

 

 

  OPC UA クライアントとして動作：ここにチェックを入れるとOPC UA クライアントとして動作 

   します。 

 

  追加：OPC UA クライアントを構成します。 

  編集：構成済みの OPC UA クライアントを編集します。 

  削除：OPC UA クライアントを削除します。 

 

  OPC UA クライアント構成一覧：追加された OPC UA クライアントの一覧です。オン に 

チェックが入っているOPC UA クライアントを起動します。 

 

OPC UA データアクセスサーバ定義の設定 

     追加もしくは編集をクリックすると OPC UAデータアクセスサーバ定義 画面が表示 

        されます。 

    

 

 

 

 

 

 

 

 

     接続名：接続を識別するためのDataHubによって使用される名前です。この名前がOPC UA 

  サーバーに登録するセッション名になります。名前の付け方は自由ですが、固有である 
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  必要があります。 

     ドメイン：接続可能な LDS（Local Discovery Server）のコンピュータ名または 

IPアドレスのリストです。 

       LDSと接続できた場合、「エンドポイントURL」のドロップダウンリストにLDSが管理 

       しているOPC UAサーバーのエンドポイントURLが入力されます。 

         ：LDSに接続し、「エンドポイントURL」を取得する要求をします。 

          ：エンドポイントURLを取得中 

          ：エンドポイントURLを取得できたことを示します。 

          ：エンドポイントURLの取得に失敗したことを示します。 

 

     エンドポイントURL：OPC UAサーバーのURLを指定します。 

 

     セキュリティポリシー：OPC UA サーバーと接続する時に使用するセキュリティポリシーを 

       設定します。このドロップダウンリストは、OPC UA サーバーから取得します。 

       OPC UA サーバーから情報が取得できなかった場合は、下記の項目がドロップダウン 

       リストに入力されます。 

         ● None 

         ● Basic128Rsa15 

         ● Basic256 

 

     ユーザ認証種別：OPC UA サーバーとセッションを作成する時の認証方法です。この 

       ドロップダウンリストは、OPC UA サーバーから取得されます。もしOPC UA サーバ 

       から情報を取得できなかった場合は、下記の項目がドロップダウンリストに入力されま 

       す。 

         ● Anonymous：OPC UAサーバーは、任意のユーザの接続を許可します。 

         ● User Name：ユーザ名とパスワードを使用します。 

         ● Another Certificate：OPC UAサーバーでは、DataHub独自の証明書以外を 

使用します。 

         ● My Certificate：OPC UAサーバーでは、DataHub独自の証明書を使用します。 

 

     ユーザ識別子：「ユーザ認証識別」で選択している項目により設定が異なります。 

         ● Anonymous：ユーザ識別子を設定する必要はありません。 

         ● User Name：ユーザ名 と パスワードを設定します。 

         ● Another Certificate：「…」ボタンが有効になります。クリックし、証明書を 

          選択してください。テキストボックスに選択した証明書のパスが表示されます。 

         ● My Certificate：Cogent DataHub に割り当てている証明書が表示されます。 
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    信頼できないサーバー証明書を受け入れる：ここにチェックを入れると、証明書が無効な 

       場合、サーバー証明書を常に受け入れるようにクライアントに指示します。 

  OPC UA クライアントは、ネットワーク経由で送付されて来た OPC UA サーバーの 

証明書を受け取ることが可能です。 

 

     有効期限が過ぎたサーバー証明書を受け入れる：ネットワーク経由でOPC UAサーバーの 

証明書を受け入れる際、証明書が期限切れな場合でも受け入れるかどうかを設定 

します。この設定は「信頼できないサーバー証明書を受け入れる」にチェックされて 

いる場合、有効となります。 

 

     接続テスト：設定した内容で接続できるかどうかテストします。 

       接続テストボタンをクリックすると、接続テスト画面が表示されます。 

 

       接続テスト 画面 

         OPC UAクライアントを追加する時の接続テスト。 

 

  開始：接続テストを開始します。 

  閉じる：接続テスト画面が閉じられます。 

 

接続テストは、下記の順序で行われます。 

１．パラメータの確認 

２．チャネル作成 

３．セッションの作成 

４．セッションの有効化 

 

問題が発生した時は、メッセージボックスに 

トラブルシューティングのヒントが表示されま

す。 

 

 

 

 

  テスト結果 

 テストが全てOKとなった場合 

 全てのテストをパスした場合、上図のように表示され、メッセージに Connection 

 succeeded と表示されます。 
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テストがNGとなった場合 

「セッションの有効化」のテストでNGとなった場

合、左図のように「失敗」と表示され、メッセージ

にエラー内容が表示されます。 

 

 

 

左図のメッセージは、「ユーザ認証種別」を“User 

Name”に設定し、存在しないユーザ名で接続した時

のメッセージです。 

 

 

 

 

   データ移動 

     データの転送方法を設定します。 

 

 

 

 

 

 

 

 

     更新周期（ミリ秒）：OPC UAサーバーからデータを取得する時間（ミリ秒） 

 

     読み込み方法：OPC UAサーバーからデータを取得する方法です。取得方法をプルダウン 

       リストから選択します。 

        ● Subscription：OPC UA通信方式としてOPC UAサーバーからの値変更通知を 

            利用します。 

        ● Synchronous Read：OPC UA通信方式として同期読み込みを利用します。 

        ● Asynchronous Read：OPC UA通信方式として非同期読み込みを利用します。 

 

     書き込み方法：OPC UAサーバーにデータを送信する方法です。送信方法をプルダウン 

リストから選択します。 
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        ● Synchronous Write：OPC UA通信方式として同期書き込みを利用します。 

        ● Asynchronous Write：OPC UA通信方式として非同期書き込みを利用します。 

 

     監視アイテムのキューサイズ：監視アイテムに変更データをキューイングする数です。 

 

     要求アイテム数：読み込み方法によって異なります。 

        ● Subscription：1つのサブスクリプションに含める監視アイテム数を設定 

            します。指定したアイテム数に達した場合、サブスクリプションを作成 

            します。 

        ● Synchronous Read：1回の要求メッセージに含める読み込み対象アイテム数を 

            指定します。 

        ● Asynchronous Read：1回の要求メッセージに含める読み込み対象アイテム数を 

            指定します。 

 

     品質がGOODのデータのみサーバーに送信する：ここにチェックを入れると、通信品質が 

       GoodのデータのみOPC UAサーバーに送信します。 

       初期値は、全て送信します。 

 

     サーバーから null データを受け付けない：ここにチェックを入れると、OPC UAサーバー 

       からのデータが null だった場合、データを受け付けません。 

       初期値は、nullのデータでも受信します。もし、null を受信した場合、データポイント 

       の値は null に設定されます。 

 

   アイテム選択 

     OPC UAサーバー上の読み込むノードを選択します。 

 

 

 

    

 

     サーバー上の全ノードを自動読込：ここにチェックを入れると、OPC UA サーバーの全ての 

       ノードを受信します。 

 

     ノードの手動読込：ここにチェックを入れると、OPC UAサーバー上の特定のノードのみ 

受信します。チェックされている場合、ノード構成ボタン が有効となります。 

     ノード構成：OPC UAサーバーと接続して、受信するノードを選択します。必須事項に入力 
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       がされていないまたは、接続が失敗した場合、エラーメッセージが表示されます。 

       

       ノード構成画面 

         ノード構成を設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

         エンドポイントURL：OPC UAサーバーのURLを指定してください。 

 

         ノード：DataHubに接続されているデータのデータポイントのリストが表示され 

ます。受信したいデータポイントにチェックを入れます。 

 

         選択済みノード：選択されたノードのリストが表示されます。 

 

         値型のノードのみ選択する：ここにチェックを入れると、選択したノードのみが 

           データノードになります。 

 

         OK：ノード構成を確定します。ノード構成画面が閉じられます。 

         キャンセル：ノード構成をキャンセルします。ノード構成画面が閉じられます。 

 

     データドメイン名：データドメイン名を指定してください。 

 

   OK：OPC UAクライアントの設定を確定します。 

      OPC UAデータアクセスサーバ定義設定画面が閉じられ、設定内容は、「OPC UA  

      クライアント構成一覧」に表示されます。 

 

   キャンセル：OPC UAクライアント設定をキャンセルします。 
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   適用 をクリックし、OPC UAクライアントが起動すると「ステータス」が“Running（起動状 

態）”になります。 
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OPC UA サーバー 

 

 

 

 

 

 

 

  OPC UA サーバーとして動作：ここにチェックを入れるとOPC UA サーバーとして動作します。 

    チェックされている場合：通信プロトコル一覧でチェックされているプロトコルで通信可能な 

      OPC UAサーバーを起動します。 

    チェックされていない場合：OPC UAサーバーを停止します。 

 

  通信プロトコル一覧：OPC UAサーバーで通信可能な通信プロトコルの一覧です。チェックが 

    入っているプロトコルでの通信を許可します。 

 

  ・ポートの編集：OPC UAサーバーで通信可能な通信プロトコル（TCP、HTTP、HTTPS）で使用 

    するポート番号を編集します。 

    編集したいプロトコルを通信プロトコル一覧から選択すると、ポート編集… ボタンが有効に 

なりますので、クリックします。エンドポイントのポート構成設定画面が表示されますので、 

ポート番号を設定します。 

 

 

 

 

 

  ・エンドポイント URL のコピー：通信プロトコル一覧で選択されているプロトコル 

    のサーバーエンドポイントのURLをクリップボードにコピーします。 

 

  コンピュータ名/IP：URLのホスト名を指定します。 

  エンドポイント名：OPC UAサーバーのエンドポイント名を指定します。 

  

  開始を容易にするために、OPC UAサーバーは最小のセキュリティ設定で構成されています。セキ 

ュリティの変更または強化する場合は、詳細設定 ボタンをクリックし、OPC UAサーバープロパ 

ティ画面を開きます。 
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セキュリティ設定 

    詳細設定 ボタンをクリックすると OPC UAサーバー プロパティ 画面が表示されます。 

 

    ・全般：セキュリティポリシー、認証方法の設定 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      サーバーエンドポイント 

        サーバーURL：OPC UAサーバーURLを選択します。 

 

        セキュリティポリシー：“サーバーURL”で指定しているURLのセキュリティポリシー 

          です。 

          ● None：署名、暗号化しない 

          ● Basic128Rsa15：署名、暗号化（AES鍵長 128）する 

          ● Basic256：署名、暗号化（AES鍵長 256）する 

          ※この設定を有効にするには、OPC UAサーバーの再起動が必要です。 

 

        ユーザ認証ポリシー：セッションを作成するときの認証方法です。 

          “セキュリティポリシー”での認証は、通信スタックレベルで認証をするため、 

          認証タイミングは異なります。 

          ● Anonymous：匿名（認証しない） 

          ● UserName and password：ユーザ名、パスワードで認証する 

          ● Certificate：証明書で認証する 
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          ※この設定を有効にするには、OPC UAサーバーの再起動が必要です。 

      クライアント証明書の検証 

        信頼できないクライアント証明書を一時的に自動で受け入れる： 

          OPC UAサーバーは、ネットワーク経由で送付されてきたOPC UAクライアント 

          の証明書を受け取ることが可能です。また、認証する時に一時的に受け入れる 

          かどうかを設定可能です。 

          チェックがついている場合は、OPC UA サーバーは一時的に信頼がおけるOPC 

          UA クライアントと認識します。この有効期間は、Cogent DataHubを再起動する 

          までとなります。 

          ※この設定を有効にするには、OPC UAサーバーの再起動が必要です。 

 

        有効期限が過ぎたクライアント証明書を受け入れる： 

          OPC UAサーバーは、ネットワーク経由でOPC UAクライアントの証明書を受け 

          入れる際に、期限切れの証明書を受け入れるかどうか設定します。この設定は、 

          「信頼できないクライアント証明書を一時的に自動で受け入れる」にチェック 

          されている場合に有効となります。 

          ※この設定を有効にするには、OPC UAサーバーの再起動が必要です。 

 

   ネットワーク経由による証明書の交換 

 

    OPC UAではアプリケーションに割り付けられている証明書を相互に検証し、通信相手 

    が信頼できるか検証する仕組みになっています。 

    Cogent DataHubは、CD-R、DVD、USBなど記憶媒体を使用できないところで証明書を 

    交換することを想定し、ネットワーク経由によって証明書受け渡しを可能としています。 
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    ・データドメイン構成：特定のデータドメインに関連付けられたグループを設定します。 

      ここ設定を有効にするために、OPC UAサーバーの再起動が必要です 

 

 

 

 

 

 

 

 

      グループ名：Cogent DataHub メニューにある「セキュリティ」で設定されている 

        グループ名です。 

      全ドメイン：チェックを入れると、Cogent DataHubで管理しているデータ全てを 

        OPC UA サーバーで公開します。 

      ドメイン構成：公開するデータをデータドメインごとに設定します。 

 

        データドメイン構成 画面 

          データドメイン構成でグループ名を選択してドメイン構成のConfigureを 

          クリックすると表示される画面です。 

          公開するデータドメインを設定します。 

          なお下図のデータドメインのリストにある「Server」は、データドメインでは 

          なく、OPC UAサーバーの診断情報です。OPC UAクライアントによっては、 

          この診断情報を公開したくない場合もあるため選択可能としました。 

 

 

 

 

 

 

 

 

 

          グループ名：設定するグループ名 

          データドメイン：データドメインの一覧です。 

          選択データドメイン：公開するために選択しているデータドメイン名の一覧 

            です。 
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    ・詳細：OPC UAサーバーの診断情報や処理の上限値を設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      サーバー診断 

        サーバー診断情報の有効化：OPC UAサーバーの診断情報も併せて公開します。 

          OPC UAサーバーの診断情報とは、現在接続しているOPC UA クライアントの 

          一覧や接続方法等の情報です。 

          ※この設定を有効にするために、OPC UAサーバーの再起動は不要です。 

 

      動作制限 

        最大セッション数：OPC UAサーバーに接続可能なセッション数の上限値を設定 

          します。チェックを入れない場合は、上限値の設定が無く、ご使用のコンピュー 

タの性能に依存します。 

          ※この設定を有効にするために、OPC UAサーバーの再起動は不要です。 

 

        最大サブスクリプション数：OPC UAサーバーで作成するサブスクリプションの 

          上限値を設定します。この上限値は、セッション毎に設定されます。チェックを 

          入れない場合は、上限数が無く、ご使用のコンピュータ性能に依存します。 

          ※この設定を有効にするために、OPC UAサーバーの再起動は不要です。 
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      オプション 

        サーバーとクライアント間で時刻同期されていなくても接続を許可する： 

          OPC UAサーバーと、OPC UAクライアントのシステム時刻が同期されていない 

          状態でも接続を許可します。 

 

        クライアントが要求した未知のノードを自動的に作成する： 

          OPC UAクライアントが要求したアイテムをDataHubが動的に追加できるように 

          設定します。 

 

      ローカルディスカバリーサーバー（LDS）への登録 

        ディスカバリーサーバーURL：OPC UAサーバーのURLを登録する Local Discovery  

                  Server(LDS)のURLを設定します。初期値は、「opc.tcp://localhost:4840/」 

          で同じコンピュータ上で動作しているLDSになります。 

          ※この設定を有効にするために、OPC UAサーバーの再起動は不要です。 
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   ローカルディスカバリーサーバー（LDS）への登録 

 

    ローカルディスカバリーサーバー（LDS）は、OPC UAサーバーのURLを管理する 

    サーバーです。Cogent DataHubで起動したOPC UAサーバーは、周期的にLDSと 

    セキュアなOPC UA通信をして接続可能なエンドポイントURLを登録します。 

    そして、OPC UAサーバーをシャットダウンするとLDSからOPC UAサーバーのエンド 

    ポイントURLを削除します。 

     

 

 

 

 

 

 

 

 

 

 

 

 

    初期値は、同じコンピュータ上で動作しているLDSに登録しますが、外部のLDSで 

    OPC UAサーバーを一括管理したい場合は、「ディスカバリーサーバーURL」を 

    外部のDLSに変更してOPC UAサーバーを再起動してください。 

 

    なお、OPC UAサーバーのエンドポイントURLをLDSに登録する場合は、セキュアな 

    OPC UA通信を使って登録します。 
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    ・HTTPアクセスルール：Webサーバーとして登録可能なURLの一覧 

      削除：選択している項目を削除します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    ・SSL/TLSバインディング：証明書で構成したポートのネットワーク設定の一覧 

      削除：選択している項目を削除します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    OK：OPC UAサーバー プロパティを設定する。 

    キャンセル：OPC UAサーバー プロパティの設定をキャンセルする。  
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サーバー情報 

 

 

    動作状態：OPC UAサーバーの動作状態を表示します。 

 

    セッション：OPC UAクライアントの接続数を表示します。 

 

    サブスクリプション：サブスクリプションの作成数を表示します。 

 

    ステータス…：ステータス… ボタンをクリックすると OPC UAサーバーステータス 画面が 

      表示されます。この画面には、各セッションに関する詳細情報が表示され、セッションを 

      クリックすると、サブスクリプションの詳細が表示されます。 

 

証明書 

    OPC UAのセキュリティは、証明書を使用して管理されます。OPC UAクライアントとサーバ 

    ーが通信するときに、お互いの信頼性を保証するために証明書を交換します。次のオプション 

    で使用する証明書とその管理方法を決定します。 

 

 

 

 

 

    証明書の拒否数：拒否したOPC UAクライアントの証明書の数です。「全て許可」ボタンを 

      クリックすると信頼する証明書としてストアに移動します。 

 

    証明書の一時許可数：一時的に接続を許可したOPC UAクライアントの証明書の数です。 

      「全て許可」ボタンをクリックすると信頼する証明書としてストアに移動します。 

      ここで管理している証明書は、Cogent DataHubを再起動すると破棄されるのでご注意 

      下さい。 

 

    設定の再読み込み：構成ファイルから構成をリロードします。その後「適用」ボタンを 

      クリックし、適用させます。適用ボタンをクリックすると、前の設定が破棄されます。 

 

    証明書の管理：証明書管理 ボタンをクリックすると 証明書管理 画面が表示されます。 
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     証明書管理 画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      証明書ストア：証明書ストアの種別を選択します。 

Type Scope Name Description 

Not 

Trusted 

ログインユーザー 

のみ 

拒否証明書ストア 通信を拒否した相手の証明書ストア

です。この証明書ストアは、現在ロ

グインしているユーザのみが使用す

る証明書ストアです。 

Trusted ログインユーザー 

のみ 

OPC UAプライベート 

証明書ストア 

信頼している通信相手の証明書スト

アです。この証明書ストアは、現在

ログインしているユーザのみが使用

する証明書ストアです。 

全ユーザ OPC UAグローバル 

証明書ストア 

信頼している通信相手の証明書スト

アです。この証明書ストアは、全て

のユーザが使用できる証明書ストア

です。 



Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   65  

全ユーザ 認証局ストア 信頼している通信相手の証明書を発

行したルート認証局または、中間ル

ート認証局の証明書を補完している

証明書ストアです。 

ログインユーザー 

のみ 

テンポラリ証明書ストア 一時的に信頼した通信相手の証明書

ストアです。 

 

      フィルタ： 

        名前：証明書ストアの名前でフィルタリングします。 

        ドメイン：ドメイン（PC名、IPアドレスなど）でフィルタリングします。 

        発行者名：証明書を発行した発行者名でフィルタリングします。 

        証明書種別：証明書の種類でフィルタリングします。 

          アプリケーション：アプリケーションの証明書 

          認証局：認証局の証明書 

          自己署名：自分で作成した証明書 

          認証局で発行：ルート認証局または、中間ルート認証局によって発行された 

            証明書 

          秘密鍵を保持：秘密鍵を持っている証明書 

 

      証明書一覧：証明書の一覧が表示されます。 

        インポート：管理外の証明書を現在の証明書ストアに保管します。 

        表示：選択している証明書情報を表示します。 

        削除：選択している証明書を削除します。 

        拒否：選択している証明書を信頼できない証明書として「OPC UAプライベート 

          証明書ストア」に保管します。 

          「OPC UAグローバル証明書ストア」から「拒否証明書ストア」へ保管する場合 

          は、管理者権限が必要です。 

        許可：選択している証明書を信頼する証明書として「OPC UAプライベート証明書 

          ストア」に保管します。 

          「OPC UAグローバル証明書ストア」から「OPC UAプライベート証明書 

          ストア」へ保管する場合は、管理者権限が必要です。 

        グローバル許可：選択している証明書を信頼する証明書として「OPC UAグローバル 

          証明書ストア」に保管します。 

          「グローバル許可」を実行する場合は、管理者権限が必要です。 
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  アプリケーション証明書：Cogent DataHub の OPC UAに割り当てられている証明書です。 

    もし、Cogent DataHubを起動した時に証明書が見つからなかった場合は、証明書を自動生成 

    して割り当てます。 

 

    証明書ビュー 画面 

      アプリケーション証明書ボタンをクリックした時に表示される画面です。 

 

 

 

 

 

 

 

 

    

 

 

 

      ストア種別：証明書ストアの種別です。 

      ストアパス：証明書ストアのパスです。Store Typeが「Directory」の場合、ファイル 

        パスになります。 

      アプリケーション名：アプリケーションの名前です。 

      組織：アプリケーションの名前です。 

      アプリケーションURI：アプリケーションを一意に示すURIです。 

      ドメイン：ドメイン（PC名、IPアドレス）です。 

      サブジェクト名：証明書のサブジェクト名です。 

      発行者名：証明書を発行した発行元のサブジェクト名です。 

      有効期限：証明書の有効期間です。 

      拇印：証明書の拇印です。 

       

      詳細…：証明書の詳細を表示するボタンです。 

      エクスポート…：秘密鍵無しで証明書を指定の場所に出力します。 

      割付け…：証明書を割り当てます。割り当てる証明書は秘密鍵を含んでいる必要があり 

        ます。 

      再発行：新しい証明書を発行し、Cogent DataHubに割り付けます。 

      OK：証明書ビュー画面を閉じます。 
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   記憶媒体による証明書の交換 

 

    OPC UAではアプリケーションに割り付けられている証明書を相互に検証して、通信相手 

    が信頼できるか検証する仕組みになっています。そのため、通信をする時に証明書を交換 

    する必要があります。「ネットワーク経由による証明書交換」で記載したようにCogent  

    DataHubのOPC UA では、ネットワーク経由でOPC UAクライアントの証明書を受け取る 

    ことが可能です。しかし、OPC UAクライアントがネットワーク経由による証明書交換を 

    サポートしていない場合は、記憶媒体などを利用して証明書交換をする必要があります。 

 

 

 

 

 

 

 

  記憶媒体による証明書の交換手順 

 

    １．「アプリケーション証明書」ボタンをクリックします。 
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    ２．証明書ビュー画面で「エクスポート…」ボタンをクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

    ３．保存先フォルダを指定して、「保存」ボタンをクリックしてください。 

      ファイル名は、下図のように自動で設定されますが、自由に変更してください。 

 

 

 

 

 

 

        ※ 上記フォルダの参照を非表示にしています。 

        ※ エクスポートする証明書には秘密鍵は含まれません。  
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３．OPC DA（OPC Data Access） 

 
 

 概 要 

OPC Data Access（Classic）は、OPC Foundationから広く使用されている産業用プロトコルです。

OPC DAサーバおよびクライアントを使用して、産業用ハードウェアやその他のデバイスをWindows

アプリケーションに接続する手段を提供します。 

 

 

 

 

 

 特 徴 

・OPC DAサーバとクライアント両方のプログラムとして同時に機能します。 

・クライアントとして機能しながら複数のOPC DAサーバからデータを読み取り、サーバとして機能 

しながらデータを任意の数のクライアントプログラムにて利用可能にします。 

・OPC DAをトンネル/ミラー機能でトンネリングし、OPC DAの使用時に一般的に発生するDCOM 

構成問題を回避します。OPC DAをトンネリングする 

 

 マニュアル：https://cogentdatahub.com/docs/#cdh-propopc.html （英文） 

 OPC DA トンネリング：https://cogentdatahub.com/docs/#cdh-opctunnelling.html (英文) 

 ビデオ：DataHubをOPCサーバへ接続する（英語） 

 

OPC Classic Data Access (DA)設定 

  DataHub の OPC Classic Data Access 機能は、OPC DA サーバと OPC DA クライアントを 

  サポートします。 

  ここでは、DataHubをOPC DAサーバ、OPC DAクライアントまたは、同時に両方機能するように 

  設定する方法を記載します。 

 

  

https://cogentdatahub.com/docs/#cdh-propopc.html
https://cogentdatahub.com/docs/%23cdh-opctunnelling.html
https://www.youtube.com/watch?v=8opuDjrH94o&feature=youtu.be&list=PL94JESkkGcmJhud_dbLMoCF3WdvOMfHQ9
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OPC クライアント 

 

 

 

 

 

 

 

 

 

 

 

     OPCクライアントとして動作：ここにチェックを入れるとDataHubは、OPCクライアント 

      として動作します。DataHubは、複数のサーバのクライアントになることが可能です。 

      接続ごとにサーバ情報を指定する必要があります。サーバをリストにしたら、オン  

            チェックボックスを使用して、接続を有効、無効にすることができます。 

 

    追加：OPCクライアントの設定を追加します。 

    編集：OPCクライアントの設定を編集します。 

    削除：OPCクライアントの設定を削除します。 

    オン：オンにチェックを入れることで設定は有効になります。 

    全データの再読込：DataHubは、全てのOPC DAサーバの接続を切断し、再接続します。 

 

 OPCクライアントとしての設定 

  ① OPCサーバとの接続を定義するには、追加をクリックします。 

 

  ② OPCサーバ定義設定画面が開きます。  

 

 

 

 

 

 

   接続名：DataHubが接続を識別する為の名前を入力します。名前は固有でなければなりません。 

   コンピュータ名：接続したいOPCサーバが実行しているコンピュータ名もしくはIPアドレスを 
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     入力します。ドロップダウンリストから選択する、もしくは直接入力して下さい。 

   OPCサーバ名：ドロップダウンリストから利用可能なサーバ名が選択可能です。 

   ドメイン名：使用したいデータドメイン名を指定します。 

 

   データ移動（データ転送） 

 

 

 

 

 

 

     更新周期（ミリ秒）：更新レートを指定します。 

       0の値は、出来るだけ早く更新する設定となります。 

読み込み定義：OPCサーバからデータを読み取る方法を選択します。 

   Asynchronous Advise： 

データが変更されるとすぐにOPCサーバは非同期でDataHubへ通知します。 

   Asynchronous Read： 

DataHubは更新レートの間隔でOPCサーバへポーリングを非同期で行います。 

   Synchronous Cache Read： 

DataHubは更新レートの間隔でOPCサーバへポーリングを行い、このスレッドに 

対する応答を待ちます。 

   Synchronous Device Read： 

DataHubは更新レートの間隔でOPCサーバへ接続されたPLCまたはハードウェア・ 

デバイスへポーリングを行い、このスレッドに対する応答を待ちます。 

 

     書き込み定義：OPCサーバにデータの書き込み方法を選択します。 

       Asynchronous Write (DA2)：DataHubはOPCサーバに対し、非同期書き込みを 

         行います。 

            Synchronous Write (DA2)：DataHubはOPCサーバに対し、同期書き込みを 

                  行います。 
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   オプション：オプションを選択します。 

 

 

 

 

 

 

 

 

 

 

     OPCアイテムのプロパティをDataHubポイントとして登録： 

       OPC アイテムを DataHub のデータポイントとして登録します。 

     読出専用：全アイテムと読出専用として指定： 

       OPC アイテムを登録する際に読み取り専用データポイントとしてDataHubに 

登録します。 

     サーバにGOODクオリティデータのみ送信： 

       Good クオリティ以外のデータ送信を防ぎます。 

     アイテムタイムスタンプにローカルタイムゾーンを使用： 

       アイテムのタイムスタンプをローカルタイムに設定します。 

     OPC DA 3.0に強制接続： 

       書込み定義のドロップダウンリストからOPC DA 3.0 方式を選択出来る様になります。   

OPC DA 3.0へ接続不可： 

       書込み定義のドロップダウンリストからOPC DA 3.0 方式を削除し、OPC DA 2.0  

       のみ有効とします。 

     サーバからのFail値を0に強制： 

       サーバからの Fail 値を 0 にします。 

     OPC DA 2.0 BROWSE_TO機能不可： 

       OPC DA 2.0 BROWSE_TO機能を無効にします。 

     インプロセスCOMサーバに接続しない： 

       インプロセスCOMサーバとアウトプロセスCOMサーバの両方が含まれる場合、 

       アウトプロセスCOMサーバに接続を行います。 

          サーバ稼動状態の待機設定： 

       OPCサーバの初期化待ち時間 

     データ読込み前に停止設定： 

       OPCサーバからデータセットを読み取る前の一時停止時間 
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   アイテム選択 

 

 

 

 

 

 

 

 

     手動登録：OPC アイテム設定画面によりアイテムを登録することが可能です。 

     全アイテムを自動読込：アイテムを自動で読み込みます。 

     フィルタ設定（空白は全てのアイテムを確認） 

 

 アイテムの選択方法 

 

  手動登録 

  ここでは、手動でOPCアイテムを選択する方法を記載します。 

  ① 手動登録にチェックを入れます。 

  ② アイテム設定 をクリックします。アイテム設定画面が表示されます。 

  ③ OPC Server Items からアイテムを選択します。 

  ④ Selected Items に選択されたアイテムが表示されます。 

  ⑤ Selected Items からアイテムを選択してDataHubポイント名を変更することが可能です。 

  ⑥ DataHubポイント名を変更後 適用 をクリックすると Selected Items に追加されます。 
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  ⑦ 削除したいアイテムは、クリックで選択し、選択削除 をクリックします。 

  ⑧ 選択終了後は、OK をクリックしてアイテム設定画面を閉じます。 

 

  全アイテムを自動読込 

  ここでは、サーバ上の全アイテムを自動で読み込む方法を記載します。 

  ① 全アイテムを自動読込にチェックをいれます。 

  ② フィルタ設定の追加をクリックし、Item Name Filter にフィルタリングするアイテム名を入力  

    します。 

  

 

 

 

 

 

 

  ③ OK をクリックし、OPCサーバ定義設定を終了します。 

  ④ 設定を反映させるために、適用 をクリックして下さい。 

 

OPC サーバ 

 

 

 

 

 

      ウィンドウズレジストリを変更しない：DataHubのレジストリ上書き設定を行います。 

      OPCサーバとして動作：ここにチェックを入れるとDataHubは、OPCサーバとして 

        動作します。 

      OPC DA2ためにVY_EMPTY標準タイプを許可： 

      OPC DA３ために： 

DataHubのOPC DA２クライアント、OPC DA3クライアントまたはその両方は、 

VT_EMPTY標準型のデータ型での送信を可能にします。 

      クライアントがVY_EMPTYタイプをリクエストした時に64ビットタイプを許可： 

        ここにチェックしない場合は、DataHubのOPC DA２クライアント、OPC DA3ク 

ライアントまたはその両方は、VT_EMPTY標準型をすべての値を32ビット数として

送信します。 



Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   75  

    COMセキュリティ 

 

 

 

      DCOMセキュリティを簡素化：COMセキュリティを緩和するには、このボックスを 

チェックして下さい。 
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４．OPC A＆E（OPC Alarms & Events） 

 
 

 概 要 

 OPC FoundationのOPC Alarms and Events（Classic）またはOPC A&Eプロトコルは、Windows 

 システムでアラームとイベントを追跡、報告、確認する方法を提供します。 

  

 マニュアル：https://www.cogentdatahub.com/Docs/cdh-propopcae.html（英文） 

 

 特 徴 

 ・OPC A&Eサーバとクライアントプログラムまたは両方として同時に機能します。 

 ・クラアインとして機能しながら複数のOPC A&Eサーバから読み取り、サーバとして機能 

  しながら任意の数のOPC A&Eクライアントプログラムでデータを利用可能にします。 

 

OPC Classic アラーム＆イベント (A&E)設定 

  DataHub の OPC A&E 機能は、OPC A&E サーバと OPC A&E クライアントをサポートします。 

  ここでは、DataHub を OPC A&E サーバ、OPC A&E クライアントまたは、同時に両方機能する 

  ように設定する方法を記載します。 

 

OPC アラーム＆イベントクライアント 

 

 

 

 

 

 

 

 

 

 

 

https://www.cogentdatahub.com/Docs/cdh-propopcae.html
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     OPCアラーム＆イベントクライアントとして動作： 

      ここにチェックを入れるとDataHubは、OPC A&Eクライアントとして動作します。 

    追加：OPC A&Eクライアントの設定を追加します。 

    編集：OPC A&Eクライアントの設定を編集します。 

    削除：OPC A&Eクライアントの設定を削除します。 

    オン：オンにチェックを入れることで設定は有効になります。 

    全データの再読込：DataHubは、全てのOPC DAサーバの接続を切断し、再接続します。 

 

  OPCアラーム＆イベントクライアントとしての設定 

 

   ① OPC A＆Eクライアントとして動作： 

    ここにチェックを入れると、OPC A＆Eクライアント機能が有効になります。 

 

   ② 追加 をクリックすると、接続するOPC A＆Eサーバを設定することが可能です。   

 

 

 

 

 

 

 

 

 

     接続名：DataHubが識別するための名前を入力します。 

       名前の付け方は自由ですが、固有である必要があります。 

     コンピュータ名：接続したいOPC A&Eサーバを実行しているコンピュータ名を入力します。 

       プルダウンリストもしくは直接入力して下さい。 

     OPCサーバ名：接続するOPC A&Eサーバ名を入力します。 

       利用可能なOPC A&Eサーバが、プルダウンリストから選択可能です。 

     データドメイン名：データポイントを受信するデータドメイン名 

     接続の遅延：初期接続の遅延時間を設定します。 

     再接続の遅延：失敗した接続を再接続するまでの遅延時間を設定します。 
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     選択：オプションを設定します。 

 

 

 

 

 

 

 

 

       読出専用：全アイテムを読出専用： 

         全アイテムを読出し専用として登録します。 

       不完全な確認対応情報を許可： 

         確認応答に完全対応していないサーバへ接続する際に利用します。 

       不規則なコンディションイベントを許可： 

         コンディションイベントに完全対応していないサーバへ接続する際に使用します。 

       最初のコンディションステータスをサーバからロード不可： 

         最初のコンディションステータスをサーバからロードしないようにします。   

       A&Eステータスを各ポイント別で表示： 

         A&E ステータスを DataHub データポイントで表示します。 

 

     フィルタ：フィルタリングアラームおよびイベントオプションを設定します。 

 

 

 

 

 

 

 

 

 

       イベントタイプでフィルタ：以下の3つのオプションでフィルタを行います。 

         シンプル：アラームに関連するフィルタを行います。 

         トラッキング：トラッキングイベントによるフィルタを行います。 

         コンディション：コンディションイベントによるフィルタを行います。 

       要度事項でフィルタ：アラーム状態の重要性または優先度を示します。 

         最少：緊急性が低い値 
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         最大：緊急性が最も高い値 

       カテゴリでフィルタ：イベントのタイプまたはイベントのカテゴリによってアラームや 

  イベントを選択出来ます。 

       エリアでフィルタ：プラント内の場所や特定マシンの存在するエリアに基づいて 

         アラームまたはイベントを選択出来ます。 

       ソースでフィルタ： 

         特定のOPC A&Eタグポイントに基づいてアラームまたはイベントを選択出来ます。 

 

   ③ OK をクリックして、設定を終了させます。 

 

   ④ 設定を反映させるために、適用 をクリックして下さい。 

 

OPC アラーム＆イベントサーバ 

 OPCアラーム＆イベントサーバとしての設定 

 

 

 

 

 

 

① OPC A&Eサーバとして動作： 

    ここにチェックを入れると、OPC A＆Eサーバ機能が有効になります。 

 

  ② このドメインからデータ使用：使用するデータドメイン名を入力します。 

    不完全な確認応答情報を許可：不完全な確認応答の受信を許可します。 

    イベント設定に変更があった場合、シャットダウンメッセージを送信： 

      イベントに設定変更があった場合、シャットダウンメッセージをクライアントへ送信 

      します。 

      クライアントがイベントを再読み込みすることができ、また新しいイベントを追加する 

           ことが可能です。 

    クライアント接続時に自動的にコンディションをリフレッシュ： 

      クライアント接続時にコンディションのリフレッシュを行います。 

 

  ③ 設定を変更後は、設定を反映させるために、適用 をクリックして下さい。 
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５．トンネル/ミラーリング 

 
 

 概 要 

 接続が難しいまたは安全でないアーキテクチャに依存するするデータプロトコルに対して、容易な 

 設定により、安全で堅牢なネットワークを提供します。DataHubのトンネリングは、必要なデータ 

 のみへアクセスを許可し、ネットワークを公開せずにデータを統合します。 

 

 

 

 

 特 徴 

 ・トンネル/ミラーリング機能は、ネットワーク上でOPCサーバとクライアント間及び、DataHub 

  製品またはサービス間を簡単なプロパティ設定により、セキュリティ面を強化した通信で接続し 

  ます。  

 ・OPCサーバとOPCクライアント間接続による複雑なDCOM設定やタイムアウトなどの問題を回避 

  することが可能です。 

 ・オプション設定で、WebSocket や SSLによる暗号化通信が可能です。 

 ・リバースプロキシとフォワード・プロキシに対応します。 

 

 マニュアル：https://www.cogentdatahub.com/Docs/cdh-proptunnel.html （英文） 

 

トンネリング/ミラーリング設定 

  DataHubのトンネリング/ミラーリング機能は、マスタとスレーブをサポートします。 

  ここでは、DataHubをトンネル/ミラー機能のマスタ、スレーブまたは、同時に両方機能するよう 

  に設定する方法を記載します。 

 

トンネリング/ミラーリングスレーブ設定 

 

 

  OPC DataHubがトンネリングスレーブ機能： 

    ここにチェックを入れると、DataHubのトンネリング/ミラーリングスレーブ機能が有効に 

なります。 

https://www.cogentdatahub.com/Docs/cdh-proptunnel.html
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マスタ追加：マスタとの接続設定を追加します。 

   編集：マスタとの接続設定を編集します。 

   削除：マスタとの接続設定を削除します。 

   

  トンネリング/ミラーリングマスタ設定 

   マスタ追加もしくは編集をクリックするとトンネリング/ミラーリングマスタ設定画面が 

表示されます。 

 

 

 

 

 

 

 

 

 

 

  

 

   プライマリホスト：マスタ側ホストコンピュータの名前またはIPアドレスを入力します。 

   ポート：ホスト側の接続ポート番号 

     ポートのデフォルト設定 

     プレーンテキスト：4502、SSL：4503、WebSocket：80、SSL+WebSocket：443 

   ローカルドメイン：スレーブ側データドメイン名（マスタへ送信したいデータのデータ 

ドメイン名） 

   リモートドメイン：マスタ側データドメイン名（マスタ側のデータ受け取りデータドメイン名） 

   セキュアSSL使用：ここにチェックを入れると、データをSSLで暗号化して送受信します。 

   WebSocket：ここにチェックを入れると、データをWebSocketで送受信します。 

   リモートユーザ名：マスタ側のTCPセキュリティ。UserNameを入力します。 

   リモートパスワード：マスタ側のTCPセキュリティ。Passwordを入力します。 

   セキュアSSL使用：ここにチェックを入れると、SSLトンネリングを使用して接続を確立し 

ます。 
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SSL使用には、下記のオプションを設定できますが、どうしても必要な場合以外は、これら 

のオプションを使用することをお勧めしません。 

Reject invalid certificate：セキュリティ証明書が無効な場合でも接続を確立します。 

Reject host name mismatch：ホスト名が一致しない場合でも接続を確立します。 

   WebSocket：ここにチェックを入れると、WebSocketを使用して接続します。 

     オプションとして、必要に応じてプロキシを介してトンネリングします。 

 Proxy address：プロキシのアドレスを設定する。 

     Proxy port：プロキシのポートを設定する。 

     Proxy username：プロキシのユーザ名を設定する。 

     Proxy password：プロキシのパスワードを設定する。 

     Always use HTTP CONNECT：HTTPの場合でもHTTP CONNECTを使用します。 

 

   データ方向：データが流れる方向を設定します。 

 

 

    

 

     読み書き：双方向データのデータを許可します。 

     読出専用：マスタからデータ受信のみ許可します。 

     書込み：マスタにデータ送信のみ許可します。 

 

   接続開始時：接続開始時の設定 

 

 

 

 

     マスタから全ての値を収得：接続開始時にデータポイントの値をマスタから収得します。 

     スレーブが全ての値をマスタに送信：接続開始時にデータポイントの値をマスタに 

       送信します。 

     タイムスタンプで同期：タイムスタンプによってデータポイントの値の同期が行われます。 

 

   接続異常発生時：接続異常発生時の品質フラグの設定 
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品質フラグを“Not Connected”と表示：スレーブ側で品質フラグを表示します。 

     品質フラグをマスタで“Not Connected”と表示：マスタ側で品質フラグを表示します。 

     品質フラグを変更しない：品質フラグの変更を行いません。 

 

      接続プロパティ 

 

    

 

 

 

 

 

      データ転送率を高速化（x86 CPUのみ）： 

        x86CPUユーザはデータ転送率を高速化することが可能です。 

      Cogent Embedded Toolkitサーバに接続： 

Cogent Embedded Toolkit をサーバとして使用する際にチェックします。 

      ハートビート（ミリ秒）：マスタへの接続を確認するためのハートビートの間隔を設定 

        します。 

      タイムアウト（ミリ秒）：ハートビートのタイムアウト時間を設定します。 

      再接続待機（ミリ秒）：切断された接続を再接続するまでの待機時間を設定します。 

 

設定後は、OK をクリックして下さい。 

    トンネリング/ミラーリングマスタ設定画面が閉じられます。 

 

     プロパティ変更後は、適用 をクリックして変更を更新して下さい。ステータスが Running  

になることを確認して下さい。 
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トンネリング/ミラーリングマスタ設定 

 

  

 

 

 

  

    プレーンテキストを使用：4502（プレーンテキストを使用したトンネリング接続の 

       ポート番号） 

       接続数：現在DataHubに接続されているデータの接続数 

   

     セキュリティ接続を使用：4503（SSLを使用したトンネリング接続のポート番号） 

       SSL証明書：SSL証明書が保存されている場所 

       接続数：現在DataHubにSSLで接続されているデータの接続数 

 

     データ再送信：データの再送信を認めます。 

       ビット、整数、浮動小数点、文字：再送信できるデータの型を選択します。 
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６．ブリッジ  

 
  

 概 要 

 ブリッジングとは、２つのデータサーバを互いに接続し、どちらもクライアントとして機能できな 

い場合に、互いのデータにアクセスできるようにすることを意味します。 

  

 

 

 

 

 1台のコンピュータに２台のOPCサーバをブリッジすることに加えて、Cogent DataHubは高度な 

ブリッジ機能を提供します。 

 

 特 徴 

 ・２つ以上のデータソースを接続してリアルタイムでデータを共有します。 

 ・トンネリング機能との組み合わせで、ネットワーク接続を介してOPCサーバをブリッジします。 

 

 

 

 

 

 ・アグリゲージョン機能により、複数の数のOPCサーバ間をブリッジします。 

 

 

 

 

 

 

 

・マウスによる簡単な設定のみでOPCサーバ間のブリッジや他データソース同士のコネクションを 

実現します。 

 ・組み込まれた線形変換機能を使用することで、データをあるサーバから別のサーバにブリッジする 

時に、データの拡大縮小、変換、正規化することが可能です。 
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 マニュアル（ブリッジ設定）： 

 http://www.cogentdatahub.com/Docs/cdh-configuringbridges.html（英文） 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propbridging.html（英文） 

 ビデオ：ブリッジ機能インターフェース操作（9:03）  

   http://www.opcdatahub.com/Demos/Bridging_DH_v1.html（英語） 

 

ブリッジ－データ交換 

   ここでは、DataHubのブリッジ機能の設定方法を記載します。 

 

  ブリッジ開始 

   

 

 

 

    ブリッジの有効：ここにチェックを入力するとブリッジが有効になります。 

  

  ステータス 

 

 

 

  

    設定済み：設定されているブリッジの数 

    実行中：現在実行されているブリッジの数 

   

              ：ブリッジ設定画面が開きます。 

 

 ブリッジ設定 

   ソース：ブリッジするデータポイント 

   デスティネーション：ブリッジ先のデータポイント 

   変換：ブリッジするデータポイントの値を変換してブリッジ先へ代入します。 

 

   変換 

     ダイレクトコピー：値をそのままコピーします。 

     線形変換：ソースを線形変換してデスティネーションへ代入します。 

       ×：ソースに設定数を掛け算します。 

http://www.cogentdatahub.com/Docs/cdh-configuringbridges.html
http://www.cogentdatahub.com/Docs/cdh-propbridging.html
http://www.opcdatahub.com/Demos/Bridging_DH_v1.html


Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   87  

       ＋：ソースに設定数を足し算します。 

     線形範囲マッピング：線形変換した値に範囲制限を設定することが可能です。 

       ソースの最小値、最大値を設定すると、デスティネーションに自動的に値が入ります。 

       最小値クランプ、最大値クランプにチェックを入れることで、範囲を制限することが 

       可能です。 

   

   同期方向：ブリッジの方向を設定します。 

     正方向（ソース → デスティネーション） 

       一貫性を強制：ここにチェックを入れると、デスティネーションが何らかの原因で変更 

されても、ソースと同じ値に強制されます。 

     逆方向（デスティネーション → ソース） 

       正方向と逆方向両方にチェックを入れると、両方向からの変更に対応します。 

 

   読み込み：変換や同期方向の設定内容に、名前を付けて登録することが可能です。 

     登録内容は、プルダウンリストより選択することが可能です。 

  

 

 

 

 

 

 

  変換設定内容の登録手順 

    変換設定を登録することが可能です。 

 

① 変換や同期方向を設定します。 

② 保存をクリックします。 

③ 変換名の入力画面の保存に保存名を入力し、 

OK をクリックします。 

    ④ 読み込み のプルダウンリストに追加されます。 
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  ダイレクトコピー設定手順 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   （例）① ソースからブリッジしたいデータポイントをクリックで選択します。 

        ここでは、DataSim:Sine を選択します。 

      ② デスティネーションからブリッジ先のデータドメインをクリックで選択します。 

        ここでは、test:SineCopy をクリックで選択します。 

      ③ ダイレクトコピーを選択します。 

            ④ 適用 をクリックすると、リストに登録されます。 

      ⑤ データブラウザでデータを確認することが出来ます。 
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  線形変換設定手順 

 

   

 

 

 

 

 

 

 

 

 

 

 

   （例）① ソースからブリッジしたいデータポイントをクリックで選択します。 

       ここでは、DataPid:PID1.Mv を選択します。 

      ② デスティネーションからブリッジ先にドメインを選択することで、選択ドメインに 

       新たなデータポイントを作成することが出来ます。 

       ここでは、test をクリックで選択します。 

       青枠のところでデータ構造の修正が可能です。 

       ここでは、test:PID.Mv → test:Mv に修正します。 

      ③ 線形変換 を選択します。 

      ④ ×、+ に計算値を設定します。 

            ⑤ 適用 をクリックすると、リストに登録されます。 

            ⑥ データブラウザでデータを確認することが出来ます。 

 

  

  

 

 

 

ｃ 
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７．DDE（Dynamic Data Exchange） 

 

 

 概 要 

 Cogent DataHubのDDE機能を使用して、システムにExcelの機能を追加することで、ライブプロセ 

スデータに基づいて、リアルタイムな分析にすることが可能です。 

 

 

 

 

 特 徴 

 ・データをドラッグ＆ドロップでExcel上に表示します。 

 ・Excelで解析したデータを制御システムへ入力。 

 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propdde.html（英文） 

マニュアル：http://www.cogentdatahub.com/Docs/cdh-connectexcel.html（英文） 

ビデオ：Sharing Excel data over a network（10:49）  

  http://www.cogentdatahub.com/Demos/Sharing_Excel_Data.html（英語） 

 

DDE 設定 

  DataHub の DDE 機能は、DDE サーバと DDE クライアントをサポートします。 

  ここでは、DataHub を DDE サーバ、DDE クライアントまたは、同時に両方機能する 

  ように設定する方法を記載します。 

 

  DDEクライアント 

 

 

 

 

 

 

 

 

http://www.cogentdatahub.com/Docs/cdh-propdde.html
http://www.cogentdatahub.com/Docs/cdh-connectexcel.html
http://www.cogentdatahub.com/Demos/Sharing_Excel_Data.html
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    DDEクライアントとして動作： 

         チェックを入れるとDataHubは、DDEクライアントとして動作します。 

      DataHubは、Excelからデータを取得します。 

     

DDEサーバ情報 

      追加：DDEサーバへの接続アイテムを追加します。 

      編集：DDEサーバへの接続アイテムを編集します。 

      削除：DDEサーバへの接続アイテムを削除します。 

 

DDEアイテム定義 

 

 

 

 

 

 

 

   接続名：接続識別名（自由に名前を設定可能ですが、固有名でなければなりません） 

    サービス：DDEサーバのサービス名 （例）Excel 

    トピック：サービスのファイル名 （例）Book1.xlsx 

    アイテム名：DataHubへ送信するデータが入力されているセルの名前 （例）Excelのセル名 

    追加：追加をクリックするとリストに追加されます。 

      修正する際は、DDEアイテム、ポイント名、データドメインを直接ダブルクリックし、 

      直接入力します。 

       DDEアイテム：アイテム名 

       ポイント名：データが送信されるデータポイント名 

       データドメイン：データポイントのドメイン名 

    削除：リストから削除されます。 

      削除したいDDEアイテムを選択し、削除をクリックします。 

    OK：DDEアイテム定義を追加します。 

    キャンセル：設定をキャンセルします。 

  

  DDEクライアントの設定手順 

    ① DataHubがデータを取得するExcelファイルを開きます。 

 ① DDE設定→DDEクライアントのDDEクライアントとして動作にチェックを入れます。 

    ② 追加をクリックし、DDEアイテム定義を設定します。 
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    ③ 設定後、OKをクリックし、DDEアイテム定義画面を閉じます。 

    ④ DDEサーバ情報リストに設定した接続名が追加されていることと、ステータスが 

      Connectedになっていることを確認します。 

 

 

 

 

 

 

    ⑤ データブラウザを開き、設定したデータポイントを確認します。 

      アイテム設定セルに値を入力し、データブラウザに値が表示されることを確認して 

下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 DDEサーバ 

  

 

 

 

 

 

 

    DDEサーバとして動作： 

      ここにチェックを入れると、DataHubはDDEサーバとして動作します。 

      DataHubからExcelへデータを取得します。 
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    DDEサービス登録 

      DDEサービス名 に datahub と表示されていることを確認してください。 

            もし、表示されていない場合は、追加 をクリックしてサービス名入力に datahub と 

      入力してください。 

追加：DDEサービス名を登録します。 

      編集：DDEサービス名を編集します。 

      削除：DDEサービス名を削除します。 

 

 

ここにチェックを入れると、Excel上で英語以外の文字列が使用可能です。 

   しかし、数値データよりも表示に時間がかかります。 

 

  DDEサーバ設定手順 

    ① DDE設定→DDEサーバのDDEサーバとして動作にチェックを入れます。 

    ② DDEサービス名に datahub が表示されていることを確認し、もし表示されていない場合 

      は 追加 をクリックし入力します。 

    ② 適用をクリックします。 

    ③ Excelを開きます。 

    ④ データブラウザをクリックし、Excelへ表示したいポイント名を選択します。 

 

 

 

    ⑤ 選択したデータポイントをクリック＆ドラックでExcelのセルへ移動します。 
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８．Quick Trend 

 
 

 概 要 

 DataHubのQuickTrend機能を使用すると、DataHubで利用可能なポイントから傾向を求めるデータ 

 を選択するだけで、データのリアルタイムの傾向チャートを作成できます。 

 

 特 徴 

・Quick Trend機能とは、DataHubの接続データを選択するだけで、リアルタイムデータを任意の数 

  だけトレンドグラフに表示することが可能です。 

 ・グラフにカーソルをあてることで、データの詳細を見ることが可能です。 

  

 ここでは、Quick Trendの設定方法を記載します。 

 詳細：https://cogentdatahub.com/features/visualization/quicktrend/ 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propquicktrend.html（英文） 

 

Quick Trend 設定 

  ここでは、DataHub の Quick Trend 機能の設定方法を記載します。 

 

 

  

 

   Quick Trend開く：ここをクリックします。 

 

   チャート 

     タイトル：タイトルを設定 

 

   X軸 

     ラベル：X軸のラベル 

     タイム間隔（秒）：X軸表示間隔 

     更新（ミリ秒）：グラフの更新間隔 

     目盛り（秒）：時間表示目盛り間隔 

     最小目盛り（秒）：最小目盛り間隔 

http://www.cogentdatahub.com/Docs/cdh-propquicktrend.html
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 Y軸 

     ラベル：Y軸のラベル 

     最小：最小表示値 

     最大：最大表示値 

     目盛り：値表示目盛り間隔 

     最小目盛り：最小目盛り間隔 

 

   設定 

     新規：名前を付けて、設定を新規作成します。 

     名前変更：設定の名前を変更します。 

     削除：設定を削除します。 

 

 

 

 

 

 

 

データポイント 

     DataHubに接続されているデータドメインから任意の数のデータポイントを選択し、 

表示することが可能です。 

 

 

 

 

 

     

      方形波：プロット間の補完を削除し、方形波の形式でグラフ表示します。 

       拡張波：ポイント変更が無くても、グラフを拡張します。 

       オフセット：オフセット（0基準） 

       スケール：グラフの表示倍率 

       バッファ：バッファのサイズ 

       ラベル：グラフのラベル 

       色：グラフの色 
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トレンド表示 

 

 

 

 

 

 

 

 

     グラフにカーソルを合わせると、その時のデータの詳細を見ることが可能です。 

     ヒストリアンを設定すると、データ履歴を見ることが可能です。 

     ※ヒストリアン設定方法は、『11.ヒストリアン』を参照して下さい。 
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９．WebView 

 
 

 概 要 

 DataHub WebViewオプションは、インターネットまたは企業ネットワークのどこからでもInternet 

Explorerを使用して、DataHubデータのアニメーション表示を設計するためのブラウザベースのエデ

ィタを提供するWebベースのデータ視覚化ツールです。 

 

 特 徴 

 ・DataHubへ接続されたデータをWebブラウザ上に高速表示させる、DataHubのデータ表示機能の 

  一つです。 

・グラフやゲージなどの4000種類以上の産業用パーツを使って、ノープログラミングでWebベース 

 のHMI（Human Machine Interface）を作成することが可能です。 

 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propwebview.html（英文） 

 

WebView Configuration 

   ここでは、WebViewの設定パラメータについて記載します。 

   WebViewを使用した画面作成方法は、『Cogent DataHub® HMI作成ガイド』に記載します。 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

http://www.cogentdatahub.com/Docs/cdh-propwebview.html
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   WebViewへのデータドメイン 

     データドメイン：WebViewで表示したいデータドメインにチェックを入れて下さい。 

     追加：データドメインを追加することが可能です。 

     リフレッシュ：データドメイン情報をリフレッシュします。 

 

   ランモード開始：WebViewがランモードで起動します。チェックなしの場合は、デザイン 

モードで起動します。 

     キオスクモード：キオスクモードで実行します。 

     キオスクモードとは、エンドユーザへ提供するランモードです。誤作動防止の為、メニュー 

バーやツールバーが表示されません。 

 

 

 

 

 

        通常のランモード                 キオスクモード 

デザインモード無効：デザインモードへの切り替えを禁止します。 

   クライアントからのデータ書込み無効：WebViewからDataHubへのデータポイントの変更を 

禁止します。 

   情報アイコンページを有効：ランモード時に WebView 画面情報   の表示を有効にしま 

す。 

   起動ページ実行：起動するページを選択することが可能です。 

     ※ユーザ毎に起動ページを指定されている場合は、無効となります。 

   カスタムブランドフォルダ選択：ログイン画面をオリジナル画面に選択します。 

     詳細は、DataHub WebViewマニュアルの Customizuing DataHub WebView を参照して 

     ください。 

 

  

 

 

 

 

 

 

 

         通常のログイン画面             オリジナルログイン画面   

メニューバー 

https://cogentdatahub.com/docs/#wv-customizing.html
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                    ：WebViewを起動します。   

 

   Silverlightアクセスポリシーサーバ 

 

 

 

 

 

 

 

     Silverlightとして動作、ポート上のポリシーサーバにアクセス： 

       デフォルト：943  

     WebViewは、Microsoft Silverlight を使用しています。 
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１０．Web サーバ 

 
 

 概 要 

 DataHubには、独自のWebサーバが付属しています。AJAX、ASP、およびMicrosoft Silverlight 

プラットフォームを含む4つの異なるWebテクノロジーをサポートします。このWebサーバは、標準 

のWebブラウザ内からすばらしいグラフィックとパフォーマンスを提供し、WebViewを動かしま 

す。 

 

 特 徴 

 ・完全にDataHubに組み込まれています。他のWebサーバは不要です。 

 ・リアルタイムにDataHubのデータへフルアクセスします。 

 ・完全な双方向のデータフローにより、Webページのデータを読み書き可能にします。 

 

 詳細：https://cogentdatahub.com/features/utilities/web-server/ （英文） 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propweb.html（英文） 

 

Web サーバ 

  ここでは、DataHubをWebサーバとして動作するように設定します。 

 

  Webサーバ 

  

 

 

   ウェブサーバとして動作： 

     ここにチェックすることでDataHubはウェブサーバとして動作します。 

  

  基本設定 

 

 

 

   ポート：TCPと接続されるポート番号です。デフォルトは80（HTTP）です。 

    DataHubが使用するポートは、DataHub専用でなければなりません。 

    他のアプリケーションと使用ポートが重複する場合は、ポート番号を変更して下さい。 

https://cogentdatahub.com/features/utilities/web-server/
http://www.cogentdatahub.com/Docs/cdh-propweb.html
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     次ページの「Webサーバのポート変更方法」を参照して下さい。 

   SSLを使用する：データをSSLで暗号化します。チェックすると接続ポートが443（HTTPS）に 

        変更されます。 

   ディレクトリをブラウズ可能：ここにチェックを入れると、ユーザはサーバ上のディレクトリを 

        閲覧することが可能です。 

   ルートディレクトリ：Webサーバドキュメントのルートディレクトリを指定します。 

 

  オプション 

 

 

 

 

 

    ログファイル エラー：エラーログが記録されているファイルのパスと名前 

    ログファイル アクセス：アクセスの成功と失敗が記録されているファイルのパスと名前 

    SSLファイル：SSLで使用されている証明書ファイルのパスと名前 

    全リクエストに対し認証を要求：すべての要求に対し、パスワードを要求します。 

      認証領域：パスワードの検証に使用されている現在の認証領域を設定します。 

 

 Web サーバのポート変更方法  

  １．使用ポートの確認 

    コンピュータで使用されているポートリストを取得します。 

① コマンドプロンプトを実行します。（管理者権限で実行） 

② netstat –p tcp –a –n –bを入力し Enter を押します。 

③ 使用されているポートを確認します。 

 

      

 

 

 

 

  ２．Webサーバのポートを変更 

    ① DataHubを起動し、Webサーバをクリックします。 

    ② 基本設定：ポートに使用されていない1025～65535のポート番号を設定します。 

      ※DataHubでは、1～1024までが既に予約されています。  
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１１．データロギング 

 
 

 概 要 

Databaseオプションを使用すると、データを書き込むため、または任意のODBC準拠データベースに 

クエリーを実行するためにDataHubを設定できます。準拠のデータベースへデータの書き込み、読み 

出しを設定します。 

  

 

 

 

 

 

 

 特 徴 

 ・WebView機能と連動させることで、Web上のHMI(Human Machine Interface)からクエリーを 

実行させ、HMI上のグラフなどにデータを表示させることも可能です。 

 

 

 

 

 

 

サポートされているデータベース 

・Microsoft Access     ・Microsoft SQL Server 

・Oracle Database     ・MySQL Server 

・Sybase          ・TimesTen 

・FileMaker                 ・その他のODBC準拠データベース 

 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propdatabase.html（英文） 

 マニュアル（Write to a Database）： 

http://www.cogentdatahub.com/Docs/cdh-logging.html（英文） 

マニュアル（Query a Database）： 

 http://www.cogentdatahub.com/Docs/cdh-dbquery.html（英文） 

http://www.cogentdatahub.com/Docs/cdh-propdatabase.html
http://www.cogentdatahub.com/Docs/cdh-logging.html
http://www.cogentdatahub.com/Docs/cdh-dbquery.html
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ビデオ：データベース書き込みーデータベーステーブルにデータを書き込む（12:55） 

ビデオ：データベース書き込みーデータベーステーブルの同じ行に書き込む（9:05） 

ビデオ：データベース読み込みーデータベースからデータを読み込む（8:24） 

 

データロギング設定 

 データベーステーブルへデータの書き込みと読み込み設定を記載します。 

 

データベース（ODBC）設定 

 

 

 

 

 

  

   ODBCデータベースにログ有効：チェックを入れると、データベースへのログ書き込みが有効に 

     なります。 

   再接続遅延（秒）：ODBC接続が切断された場合、再接続を実行するまでの待機時間 

    最大キュー処理：保留中の活動要求を保持できるメモリ領域 

    スクリプトログのデバッグ情報を表示：チェックを入れると、スクリプトログにデバッグ情報 

            が記録されます。 

   

  ストア・アンド・フォワード： 

    データベースがつながっていない時にデータを一旦蓄積するための設定です。 

 

 

 

 

 

 

 

   ストア・アンド・フォワード有効：ストア・アンド・フォワードを有効にします。 

     ディスクにキュー書き込み：トランザクション・キュー内のデータは、最初にディスク 

キャッシュに書き込まれた後にデータベースに書き込まれます。 

クラッシュに対する最も安全な保護は、ここにチェックを入れ、ディスクに書き込み 

https://www.youtube.com/watch?v=uFo-BL9MSAs&feature=youtu.be&list=PL94JESkkGcmJhud_dbLMoCF3WdvOMfHQ9
https://www.youtube.com/watch?v=23HCQg6M_nc&feature=youtu.be&list=PL94JESkkGcmJhud_dbLMoCF3WdvOMfHQ9
https://www.youtube.com/watch?v=271zvDCuej8&feature=youtu.be&list=PL94JESkkGcmJhud_dbLMoCF3WdvOMfHQ9
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遅延にチェックを入れないことです。 

     ディスクに書き込み不可：トランザクション・キュー内のデータはメモリに格納され、 

              ディスクに書き込みません。 

     ディスクに書き込み遅延：トランザクション・キュー内のデータは、最も適切なタイミング 

              でディスクに書込みます。 

     フォワード時に重複を許可：キャッシュからデータを送信している時にネットワーク通信 

       不能になった場合、キューやキャッシュの先頭から送信を再開します。 

       チェックがない場合、DataHubは、データの重複が無いように常にキャッシュの位置を 

              追跡します。データの重複はありませんが、この処理は全ての転送速度に影響します。 

     トレーメニューに統計を許可：DataHubシステムメニューにデータロギング統計ウィンドウ 

              を追加し、開くことが可能です。 

     キャッシュディレクトリ：キャッシュディレクトリのパス 

     最大キャッシュサイズ（MB）：キャッシュに割り当てるディスク領域のサイズ 

 

  データベースの設定方法 

 

  ① データを保存するための 空のデータベース を準備して下さい。 

    ここでは、Microsoft Access を使用し、ファイル名を databasetest.mod としました。 

   （ここでは、Microsoft Access を使用しますが、推奨しているわけではありません。） 

  ②          ：データベースへの書き込みを設定します。 

  ③ DSN を選択します。 

  ④ DSNアドミニストレータを開く をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

  ⑤ ODBCデータソースアドミニストレーター画面が開きます。 
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    ユーザDSNもしくはシステムDSNを選択し、追加 をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

    ⑥ データソースの新規作成画面が開きます。 

       Microsoft Access Driver(*.mdb) をクリックで選択し、完了 をクリックします。 

 

 

 

 

 

 

 

 

 

 

  ⑦ ODBC Microsoft Access セットアップ画面が開きます。 

    選択をクリックします。 
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  ⑧ データベースの選択画面が開きます。 

    フォルダから先ほど作成した、空のデータベースの保存フォルダを選択します。 

    データベース名のリストからファイルを選択します。 

 

 

 

 

 

 

 

 

 

 

 

  ⑨ OKをクリックします。データベースの選択画面が閉じられます。 

  ⑩ ODBC Microsoft Access セットアップ画面のデータベース:に設定ファイルが表示されて 

       いることを確認します。 

       データソース名を入力し、OKをクリックします。 

       ODBC Microsoft Access セットアップ画面が閉じられます。 

 

 

 

 

 

 

 

 

 

 

 

  ⑪ ODBCデータソースアドミニストレーター画面のユーザデータソースから設定データソースが 

       追加されていること確認し、OK をクリックします。 

       ODBCデータソースアドミニストレーター画面が閉じられます。 
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  ⑫ データベース（ODBC）データロギング設定画面のデータソースネーム（DSN）を設定 

    します。 

       既存DSNを選択 のプルダウンリストから、先ほど作成したDSNを選択します。 

 

 

 

 

⑬       をクリックします。 

  ⑭ ステータスが、接続不可能 → 接続 になればDSNの設定は完了です。 

                  

                 → 

  ⑮ テーブルの設定  

         テーブルを選択します。  

  ⑯ テーブル名を設定します。 

 

 

  ⑰            をクリックします。 

  ⑱ Colum Name を設定  
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  ⑲ アイテム の設定 

    <Key> ：自動連番 

    <point> ：右リストからデータポイントを選択し、＜point＞を選択します。 

  ⑳ プロパティの設定 

     データポイントの値を保存する場合は、保存する属性を選択します。 

  ㉑ データタイプ の設定 

     データタイプを設定します。※使用するデータベースによって選択項目に違いがあります。    

  ㉒ テーブル作成 ボタンをクリックします。 

   ㉓ アクション設定の 作成 ボタンをクリックします。 

   

 

 

 

    アクション設定リストに追加されます。 

     アクション設定リストの条件を変更する場合は、クリックで選択した状態で変更して 

         下さい。 

  ㉔ トリガの設定 トリガを設定します。 

 

 

 

 

 

 

    ポイント変更：トリガとなるデータポイントを設定します。このデータポイントの値の変更が 

トリガとなります。 

    リピートタイマー：設定秒毎にトリガが発生します。 

    特定時刻：設定時刻にトリガが発生します。 

    後：設定秒後にトリガが発生します。 

    トリガ無し：トリガを設定しません。 
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 ㉕ 条件の設定 データベースへの書き込み条件を設定します。 

 

 

 

 

 

 

 

  ㉖ 設定後、アクション設定 変更 をクリックすると、リストが更新されます。 

  ㉗ 適用、終了をクリックします。   

  ㉘ データベースを開いてデータが書かれていることを確認して下さい。 

 

 

 

 

 

 

 

 

 

データベースからクエリー 

 

 

 

 

 

    ODBCデータベースからのクエリー有効： 

      ここにチェックを入れると、ODBCデータベースからの読み込み機能が有効になります。 

    再接続遅延（秒）：ODBC接続が切断された場合、再接続を実行するまでの待機時間。 

    最大キュー処理：保留中の活動要求を保持できるメモリ領域。 

    スクリプトログのデバッグ情報：読み出しクエリー等がスクリプトログに残ります。 

 

 

M2M 設定ガイド 
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  ODBCデータベースクエリー設定 

  ① 設定をクリックします。 

  ② DSNの設定 

   プルダウンリストから既存DSNを選択し、接続 をクリックします。 

   ステータス：設定完了後に接続と表示されます。  

 

 

 

 

 

 

   アクション設定の 作成 をクリックすると、リストに追加されます。 

 

 

 

  ③ データベースクエリー設定 

 

 

 

 

 

 

 

 

   ラベル：クエリーの名前を入力 

   SQL言語により、データベースのクエリーを設定することが可能です。 

 

  (例)  SELECT TOP 10 ts, Pv, Mv, Sp    ts，Pv，Mv，Spのトップから10個選択 

        FROM databasetest         databasetestから 

        ORDER BY ts DESC                 ts列から降順 

 

   列ごとに単一ポイント：１ポイント名で１列分データ 

   全データセットを単一ポイント：１ポイント名で全データ （今回はここにチェックを 

     いれます。） 

     データポイントの指定は、既存のデータポイントの他に新たに作成することも可能です。 

  ④ トリガ設定 

ｘ
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    トリガを設定します。 

 

    

   

 

 

 

    ポイント変更：トリガとなるデータポイントを設定します。このデータポイントの値の変更が 

トリガとなります。 

    リピートタイマー：設定秒毎にトリガが発生します。 

    特定時刻：設定時刻にトリガが発生します。 

    後：設定秒後にトリガが発生します。 

    トリガ無し：トリガを設定しません。 

  ⑤ 条件設定 

    条件の設定を行います。条件が設定されていない場合は、トリガ発生ごとにデータベースから 

        読み出されます。 （今回は、何もチェックしません。） 

  ⑥ 設定後、変更をクリックすると、リストが更新されます。 

  ⑦ 適用後、終了 をクリックします。 

  ⑧ データブラウザ でポイントを確認することが可能です。 
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１２．ヒストリアン 

 
 

 概 要 

高速プロセスですべての値を記録する必要がある場合は、SQL Server、MySQL、Oracleなどのリレ 

ーショナルデータベースでは対応できない可能性があります。Historian機能を使用すると、

DataHubはプロセスデータ用のフライトレコーダーのように機能し、1秒あたり何百万ものトランザ

クションを処理することが可能な、データの高速な保存と取得を実現します。 

 

 特 徴 

・ヒストリアンとは、高速かつ省リソースなデータ保存機能です。またディスクスペースの管理機能 

  を有しており、保存データ量をディスク容量に応じて設定することがが可能です。 

  ・この保存データをQuickTrend機能やWebViewのTrendChartによりデータ履歴を表示することも 

   可能です。 

 

 詳細：https://cogentdatahub.com/features/utilities/historian/ 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-prophistorian.html（英文） 

 

データヒストリアン 

 ここでは、ヒストリアンの保存設定について記載します。 

 

 

 

 

 

 

 

  

 ヒストリカルデータの収集有効：ここにチェックを入れることで有効になります。 

 ヒストリグループ：設定されたヒストリアンのリストが表示されます。 

   追加：ヒストリアンの設定を追加します。 

   編集：ヒストリアンの設定を編集します。 

   削除：ヒストリアンの設定を削除します。 

http://www.cogentdatahub.com/Docs/cdh-prophistorian.html
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 ヒストリカルデータ保存設定 

   追加、編集をクリックすると表示されます。  

 

 

 

 

 

 

 

 

   

   グループラベル：グループを識別するために使用される任意のテキスト文字列 

   ベースディレクトリ：保存ファイルが格納されるフォルダ 

   ファイル変更の間隔：保存ファイルを変更する間隔 

   データ保存：保存ファイルの保管期間 

   ディスクへフラッシュ：ディスクへの保存頻度 

 

デッドバンド 

     デッドバンド値に大きな変化がある場合にのみデータを格納することで、格納される 

          データ量を削減させることが可能です。 

 

 

 

 

 

 

   In-Memoryキャッシュ    

     値の保存用に割り当てられたメモリの量を指定します。 

     １データには、“値”、“品質”、“タイムスタンプ” が含まれ、１データ 24byte です。 

 

 

 

     In-Memoryキャッシュサイズ（値数）：データ数を表します。 
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   ポイント選択 

     ヒストリカルデータを保存したいデータポイント名にチェックを入れて下さい。 

 

 

 

 

 

 

    

 

   OK をクリックして、ヒストリカルデータ保存設定画面を閉じて下さい。 

 

  

 

 

 

 

    ヒストリグループに設定が反映されているのを確認し、適用 をクリックして下さい。 

 

    グループ設定どおりにフォルダ、ファイルが作成されていることを確認して下さい。 

  



Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   115  

１３．Sys モニタ（システムモニタ） 

 
 

 概 要 

 DataHubが実装されているコンピュータのシステムパフォーマンスデータにアクセスし、CPUの 

 使用率、メモリ使用率、プロセスID、ディスク容量、ネットワークトラフィックをモニタリング 

 することが可能です。 

 

 

 

 

 

 

 

プロセスIDを監視することによって、特定のプロセスが実行されているか否かを確定することが 

でき、その情報をデータベースに保存、メール送信のトリガとして使用することが可能です。 

（ビデオ参照） 

 

 

 

 

 

 

 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propsysmon.html（英文）  

 

  

http://www.cogentdatahub.com/Docs/cdh-propsysmon.html
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システムモニタ設定 

 ここでは、システムモニタの設定方法について記載します。 

 

 

 

 

 

  システムモニタを起動：ここにチェックを入れるとシステムモニタ機能が動作します。 

  データドメイン：ここで設定されたデータドメインのデータポイントとして追加されます。 

  更新周期：この設定周期でデータが更新されます。（最小設定値100ミリ秒） 

 

  パラメータ無効時：選択パラメータが無効の場合の設定をします。 

 

 

 

 

  値設定：無効時の値を設定します。 

  クオリティ設定：無効時のクオリティを選択します。 

 

  ポイント名：システムモニタはシステムプロパティ名に基づいて自動的にDataHubのデータ 

    ポイント名を作成します。一部のクライアントプログラムでは、特殊文字を含むポイント名と 

    連携することが出来ません。このセクションでは、ポイント名を構築する時にプロパティ名 

    から削除される文字を指定します。 

 

 

 

 

  システムモニタパラメータ：選択したパラメータが表示されます。 
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   選択削除：システムモニタパラメータから選択を削除します。 

 

   リストから選択：システムパラメータの選択画面を表示します。 

 

 システムプロパティ選択 

    ここで、モニタリングしたいシステムパラメータを選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

説明を表示する：パラメータ説明を表示します。 

追加：選択されたパラメータをシステムモニタのパラメータとして追加します。 

閉じる：システムプロパティ選択画面を閉じます。 

 

 設定後は、適用 をクリックして設定を反映させて下さい。 
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 データブラウザにて設定したデータドメイン（ここではSystem）にデータポイントが追加されて 

 いることを確認します。 
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１４．E メール/SMS 

 
 

 概 要 

 設定した条件に基づいて、任意のデータポイントについて電子メールおよびSMSメッセージを送信し 

ます。  

  

 特 徴 

・各機能のデータをトリガに電子メールやSMSテキストメールを送信することが可能です。 

 ・異常値の監視、定期的なデータの取得などに使用することが可能です。 

・条件ごとに受信先の指定、複数の受信先を設定することが可能です。 

  

 詳細：https://cogentdatahub.com/features/utilities/email-sms/ 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propemail.html（英文） 

 ビデオ：http://www.cogentdatahub.com/Demos/Email_DH_v1.html（英文） 

 

Email と SMS 設定 

 ここでは、電子メールの設定方法を記載します。 

 

 

 

 

 

 

 

 

 

 

 

 メールサーバ設定：ご契約されているプロバイダにご確認下さい。 

   SMTPサーバ：SMTPサーバ名 

   ポート（デフォルト25）：SMTPポート番号 

   送信者メールアドレス：送信元メールアドレス 

   ユーザ名：SMTPアカウントにアクセスするための名前 

https://cogentdatahub.com/features/utilities/email-sms/
http://www.cogentdatahub.com/Docs/cdh-propemail.html
http://www.cogentdatahub.com/Demos/Email_DH_v1.html
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   パスワード：設定パスワード 

   セキュリティ：メール送信の際のセキュリティを設定します。 

  

 

 

 

 

 

 Eメール/SMSイベント設定 

  Eメール/SMSイベント有効化：ここにチェックを入れると有効になります。 

    確認 をクリックすると、Eメール/SMSイベント設定画面が表示されます。 

 

 Eメール/SMSイベント設定 

  Eメール 

 

 

 

 

 

 

   メッセージタイプ：テキストメッセージとHTMLメッセージが選択可能です。 

   受信者：メールの送り先を入力します。カンマで区切って複数設定することが可能です。 

 

   メッセージ内容 
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   件名：メールのタイトル 

    本文： 

      このファイルを使用：指定ファイルを使用（HTMLファイルなど） 

      次のテキストを使用：下記にて送信テキストが作成可能です。 

    

    ポイント挿入：データドメインもしくはデータポイントをテキストに挿入することが 

      可能です。 

 

     データポイントの挿入方法 

     ① テキストの挿入したい位置にカーソルを設定します。 

② 右の表にDataHubで管理されているデータドメインまたはデータポイントが表示され 

  ますので選択します。 

③ 名前、値、時刻、品質を選択します。 

④ ポイント挿入 をクリックすると、テキストに挿入されます。 

 

 

 

 

 

 

     

  アクション設定  

 

 

 

 

 

     オン：チェックを入れることで、このメール送信条件を有効にします。 

作成：メール送信条件を新規作成します。 

     変更：メール送信条件を変更します。 

     削除：メール送信条件を削除します。 

 

 

 

 

      

時刻 

名前 
値 

品質 
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トリガ 

 

 

 

 

 

 

 

 

  トリガイベント定義 

    ポイント変更：設定ポイントデータの変更をトリガに設定します。 

    リピートタイマー：設定タイマー(秒)経過ごとに繰り返します。 

    特定時刻：年月日時分秒を設定します。 

    後：設定秒後にトリガが発生します。 

    トリガ無し：トリガを設定しません。 

 

条件 

 トリガ発生時に該当する条件を定義します。 

 条件が該当する場合は、設定した受信者にメールが送信されます。 

 

 

 

 

 

 

 

 

 

 

        ⑤ アクション設定の 作成 をクリックします。 

 

        ⑥ アクション設定に設定内容が追加されていることを確認します。 
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          ⑦ 適用 をクリック後、終了 をクリックするとEメール/SMS 

             イベント設定画面が閉じられます。 

     

      ⑧ 設定後は、適用 をクリックして設定を反映させて下さい。 
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１５．Redundancy  

 
 

 概 要 

特別な保護対策が必要なシステムでは、Cogent DataHubはホットスタンバイ冗長性をサポートしま 

す。2つの同一のデータソースを設定し、一方が停止すると、DataHubは自動的にもう一方に切り替 

わります。 

 

 

 

 

 

 

 特 徴 

・シームレスな切り替えにより、データ損失を最小限に抑えます。 

・データソースが変更されたときのみトリガされます。 

・単一のポイントまたは、グループ内のポイントに対して、ポイントの値または品質の変化をトリガ 

 にすることが可能です。 

 

詳細：https://cogentdatahub.com/features/integration/redundancy/ 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propredundancy.html（英文）  

  

Redundancy 設定 

ここでは、リダンダンシーの設定方法を記載します。 

 

 

 

 

 

 

 

 

 

追加：リダンダンシーを追加します。 

https://cogentdatahub.com/features/integration/redundancy/
http://www.cogentdatahub.com/Docs/cdh-propredundancy.html
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  編集：設定されたリダンダンシーを編集します。 

  削除：設定されたリダンダンシーを削除します。 

 

  ① 追加（または 編集）をクリックします。Redundancy設定画面が開きます。 

 

    

 

 

 

 

 

   データドメイン 

ラベル：識別ラベルを設定します。 

     ソースドメイン1：最初のデータソースとして入力されるソースドメインを設定します。 

     ソースドメイン2：データとして入力されるソースドメインを設定します。 

     優先ソース：優先されるソースドメインを設定します。 

       優先データソースが指定されている場合、他のソースが使用可能であっても、DataHub 

       は可能な限りそのソースを使用します。 

       優先ソースを設定しない場合は、DataHubは無効な基準を満たすまで、現在使用使用し 

       ているデータソースを維持します。 

     アウトプットドメイン：クライアントが接続する冗長接続の出力となるデータドメイン名。 

 

 

 

 

 

 

 

 

   インプットドメイン無効条件： 

     DataHubがある冗長データソースから別の冗長データソースに切り替える条件を設定しま 

す。 

    データクオリティ：  

     ソースドメインが指定したデータポイント品質条件を満たしたときにデータドメイン 

を無効化します。 

    データ値：ソースドメインが指定した値条件を満たしたときにドメインを無効化します。 
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    不特定ポイント：データドメイン内の全てのポイントがドメイン無効条件の範囲となります。 

    特定ポイント：指定した名前のデータポイントがデータドメイン無効条件の範囲となります。 

 

データフロー検出： 

    データフローを検知し、指定時間変化が無かった場合、データドメイン切り替えが発生 

    します。 

    指定したポイントがソース1,2ともに変化が無かった場合は、データドメイン切り替えは発生 

しません。  

 

 

 

  選択 

 

 

 

 

 

 

 

    スイッチ不可能、常に第一ソースを使用： 

      スイッチを行わず、常に第一ソースをアウトプットします。 

      この設定は二重化ではなく、第一ソースドメインのコピーに用いられます。 

    スイッチ時にアウトプットドメインのリフレッシュ不可： 

      通常は、スイッチを行う際にアウトプットドメインのデータはリフレッシュ（スイッチ後 

      のドメインに更新）されます。 

       本オプションを指定している場合は、スイッチ時にリフレッシュを行わず、スイッチの後 

      に更新があって初めてデータ更新が行われます。 

    アウトプットドメインへのデータモデルコピーは不可： 

         出力するアウトプットドメインの階層データモデルは維持されます。 

       または、データモデルが存在しない場合は、アウトプットドメインは階層のない平坦な 

            データモデルとなります。  

    スイッチ時に常にデータモデルをコピー： 

（階層的な）データモデルのコピーを強制します。 

    アウトトップドメインからの書込値は無視： 

      アウトプットドメインデータ側から値の変更があっても、ソース元のドメインデータには 

            変化は行いません。 
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    インプット情報をデータポイントで表示：     

      有効、無効、初期化されていないデータポイントの数を表示するデータポイントを作成 

            します。 

    初期化されていないポイントの対応： 

      ラジオボタンでは初期化されていないデータポイントを正常、無効、有効どれに 

      分類するかを決定します。 

      ※ 初期化されていないデータポイントはデータがEmpty となっているデータポイント 

        です。 

 

   ステータスとコントロールデータポイント（空白は無効） 

 

 

 

 

 

 

     現在ソース番号ポイント：現在出力されているソースドメイン番号です。 

     ドメイン1の現在ステータスポイント：ソースドメイン1の状態を表します。 

     ドメイン2の現在ステータスポイント：ソースドメイン2の状態を表します。 

     優先ソース番号ポイント：優先ソースにチェックを入れたソースドメイン1,2 を表します。 

   

  ② 設定後、OK をクリックします。 

  ③ 設定を反映するために 適用 をクリックします。 



Cogent DataHub® 入門ガイド 

    

S021601-001-120 2019/1/6   128  

１６．USB カメラ 

 

 

 

 概 要 

 USBカメラに接続し、ライブビデオや画像を取得することが可能です。 

 

 

 

 

 

 

 特 徴 

 ・Web上のHMIにライブビデオや画像を表示 

 ・遠隔地からカメラのパラメータを制御 

 ・カスタマイズによりタイムスタンプの追加や障害検出、モーションセンシングなどを追加 

 

 詳細：https://cogentdatahub.com/features/visualization/camera/ 

 ビデオマニュアル：Cogent DataHub Camera Support (英語) 

 マニュアル：https://cogentdatahub.com/docs/#cdh-propcamera.html （英文）  

 

 カメラ設定 

  

 

 

 

 

 

 

  カメラ有効：ここにチェックを入れるとカメラ機能が有効になります。 

 

  追加：カメラの設定を追加します。 

  編集：カメラの設定を編集します。 

  削除：カメラの設定を削除します。 

https://www.youtube.com/watch?v=E-Oq-eh7sc4&feature=youtu.be&list=PL94JESkkGcmJpyxzHd5emYMyv3jpcFC2R
https://cogentdatahub.com/docs/#cdh-propcamera.html
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   カメラ定義 画面 

     追加、編集をクリックすると表示される画面です。 

     カメラの選択や画像の解像度などを設定します。 

 

     カメラ 

 

 

 

 

 

 

       カメラ名：システムで使用可能なカメラをリストから選択してください。 

 

       解像度：カメラ名で選択されたカメラでサポートされている解像度、フレームレートの 

         リストが表示されます。リストから選択します。 

 

       フレームタイミング（ms）：フレームタイミングを設定します。 

 

     イメージ 

 

 

 

       スケール：次のパラメータに従って元の画像を拡大/縮小します。 

 

       横：最大横幅（ピクセル単位） 

       縦：最大縦幅（ピクセル単位） 

 

       アスペクト比を保存：元の画像のアスペクト比を保持します。 

         イメージの設定が元の画像のアスペクト比を保持していることを確認して 

         ください。上記の設定を１つ上書きする可能性があります。 

 

       クオリティ：画質をパーセンテージで表したもの。 

         高解像度などの品質が必要でない場合等、この設定を下げることでシステム 

         リソースを大幅に節約することが可能です。 
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     ポイントバインディング 

       カメラのパラメータをデータポイントの値として監視、制御することが可能です。 

       使用するカメラにパラメータが対応していることが前提です。 

 

       データドメイン：設定カメラの画像イメージ、パラメータのドメイン名の設定 

 

       プレフィックス：各ポイント名に同じプレフィックスを付けることができます。 

         これは、複数台のカメラが設定されている場合に役立ちます。 

       

       カメラパラメータの設定 

         オン：カメラパラメータを有効にします。 

         プロパティ：カメラ機能名 

         ポイント名：データポイント名（名前は変更可能です） 

         書き込み可能：パラメータの変更を可能にします。 
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 カメラの設定手順 

  １．カメラを設定するには、まずUSBカメラをDataHubが起動しているサーバーに接続します。 

  ２．DataHubのカメラアイコンを選択し、カメラの設定画面を開きます。 

  ３．カメラ設定のカメラ有効にチェックを入れます。 

  ４．追加をクリックし、カメラの選択と設定を行います。 

  ５．カメラ定義画面が開きます。 

  ６．カメラ名と解像度をプルダウンリストから設定します。 

  ７．ポイントバインディングのデータドメイン名を入力し、有効にするカメラプロパティのオンに 

    チェックを入れます。 

  ８．カメラ定義を設定後、OKをクリックしカメラ定義画面を閉じます。 

  ９．カメラ設定のリストにカメラ定義の設定が追加されていることを確認し、オンにチェックを 

    入れ有効にします。 

  １０．画面下の適用をクリックし、設定を適用させます。 

 

 ・カメラデータの確認 

    カメライメージの確認 

     カメラ設定のリストから設定を選択した状態で、右側にある ビュー… をクリックします。 

     カメライメージウィンドウが表示されます。 

 

    データポイントの確認 

     データブラウザクリックし、カメラ定義で設定したデータドメイン、データポイントを確認 

します。 

 

    WebView上で確認 

     DataHubのWebViewアイコンを選択し、WebViewへのデータドメインを追加する。 

WebViewを起動させ、コントロール・アイコンのImageのプロパティの Basic Properties 

→ 

Image Data の Binding:Point を選択し、カメラ定義で設定したデータポイント名を設定 

します。 
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１７．Modbus 

 
 

 概 要 

 Cogent DataHubのModbus TCP機能は、Cogent DataHubと任意のModbus TCP/Ethernet準拠 

 のPLCまたはデバイス間のリアルタイムデータ交換を提供します。 

  

 

 

 

 

 

 

 特 徴 

 ・Modbus機能は、Modbus/TCP通信のマスタをサポートします。 

 ・任意の数のスレーブと接続可能です。 

 ・OPC DA機能と共使用すると、DataHubをModbus OPCサーバとして機能させることが可能です 

 

 詳細：https://cogentdatahub.com/features/protocols/modbus-driver/ 

 マニュアル：https://cogentdatahub.com/docs/#cdh-propmodbus.html（英文） 

 

Modbus ドライバ設定 

   

  Modbus マスタ 

 
 

https://cogentdatahub.com/features/protocols/modbus-driver/
https://cogentdatahub.com/docs/#cdh-propmodbus.html
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    Modbusマスタ有効： 

     ここにチェックを入れると、DataHubはModbusマスタとして動作します。 

    スレーブ追加：接続するスレーブを追加します。 

    スレーブ編集：接続するスレーブの情報を編集します。 

    スレーブ削除：スレーブの情報を削除します。 

    Modbus設定ファイル...： 

     ここをクリックすると、Modbusの設定ファイルをDataHubの設定ファイルへロードしま 

     す。 

 

 Modbusマスタ機能の設定  

  DataHubをModbusのマスタとして動作させるための設定を記載します。 

  ① スレーブ追加 もしくは、スレーブ編集 クリックします。 

  ② Modbusスレーブ設定 画面が表示されます。 

Modbusスレーブ設定 

スレーブへの接続設定をします。 

 

 

  

  

 

 

 

 接続設定 

       スレーブ名：DataHubが接続を識別する為の名前を入力します。 

        名前は固有でなければなりません。 

        デフォルトとして自動生成されます。MBNNN NNNは000から始まるインクリメント 

        番号です。 

   ホスト / IP アドレス：Modbusスレーブのホスト名またはIPアドレス  

   ポート：スレーブへの接続に使用されるポート番号です。 

     デフォルトポート番号は、502です。 

   リトライ時間(ms)：失敗した接続を再接続するまでの遅延時間を設定します。 

   ソケットを共有する：ここにチェックを入れると、Modbusドライバは、同じ 

     IPアドレスとポート番号への接続を１つのソケット接続に結合します。 

   ソケット上のメッセージをシリアライズ（直列化）する 
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 Modbus オプション 

   

 

 

 

 

 

  DataHubは、次の表に示すように、最も一般的に用いられるModbusの９つのリード、 

  ライト機能をサポートしています。 

 

  Modbus Read Functions 

Code Function Type Function Name 

1 Internal Bits or Physical Coils Read Coils 

2 Physical Discrete Inputs Read Discrete Inputs 

3 Int/Physical output Registers Read Holding Registers 

4 Physical Input Registers Read Input Registers 

  

   Modbus Write Functions – オプション 

Code Function Type Function Name 

5 Internal Bits or Physical Coils Write Single Coil 

6 Int/Physical output Registers Write Single Register 

15 Internal Bits or Physical Coils Write Multiple Coils 

16 Int/Physical output Registers Write Multiple Registers 

22 Int/Physical output Registers Mask Write Register 

 

      ポーリングレイト (ms)：DataHubがModbusスレーブへポーリングする頻度 

   メッセージ最大長 (bytes)： 

     スレーブデバイスがサポートできる最大メッセージ長。 

   スレーブID：スレーブ装置の識別ID 

   タイムアウト (ms)：応答のタイムアウト 

 

 アドレッシング指定 
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    レジスタ内の開始ビット番号を 0 から 1 にします： 

     レジスタ内部の開始ビットを0ではなく１からにします。 

   レジスタ内の最上位ビットを Bit.0 にします： 

     レジスタ内の最上位ビットを０にします。 

   アドレスの開始を0から1にします： 

     アドレスの開始を 0 から 1 にします。 

 

 データポイント 

     スレーブ接続のためのデータポイントの設定を行います。 

 

 

 

 

 

 

 

   データドメイン：設定するデータポイントのドメインを設定します。 

   ポイント追加：データポイントの追加と設定を行います。 

   範囲指定追加：範囲設定してデータポイントの追加と設定を行います。 

   変更：データポイントの設定を編集します。 

   削除：設定したデータポイントを削除します。 

 

  ③ ポイント追加 をクリックします。 

  ④ データポイントアドレス設定 画面が開きます。 

データポイントアドレス設定 

データポイントのアドレスとデータタイプを設定します。 
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 アドレスとタイプ： 

   I/O タイプ：プルダウンリストから入出力のデータタイプを設定します。 

     ０：Digital Output（coil） 

     １：Digital Input（discrete） 

     ２：Analog Input（input register） 

     ３：Analog Output（holding register） 

      データタイプ：データタイプを設定します。 

     アナログ入出力を選択した場合に表示されます。 

     Integer：整数 

     Float：浮動小数点 

     String：文字列 

   エンコーディング：エンコードする形式を設定します。 

     ASCII  UTF-8  UFT-16 

   スワップ：Modbusのスレーブ側のデバイスに格納されたデータのbyteの順序を設定 

     します。 

          Bytes     Words     DWords 

   符号：符号付きまたは、符号なしを選択します。 

          Signed    Unsigned 

   デッドバンド：デッドバンドの値を設定します。 

     設定を0にすると、デッドバンドが全く適用されず、すべての値の変化が有意義で 

     あるとみなされます。 

   アドレス（オフセット）：Modbusのレジスタアドレス 

     このアドレスは、DataHubのデータポイントにリンクされます。 

 

   ポイント名：ドメイン名以下のデータポイント名  （ 例 int.output1 ） 

   Modbusデバイスへの書き込み許可：ここにチェックをいれると、Modbusデバイスへの 

     書き込みを許可します。 

 

 変換：値の変換 

   データを変換してDataHubのデータポイントへ渡します。 

   変換しない：Modbusからの入力値は変換せず、データポイントに渡します。 

   線形変換：Modbusからの入力値を線形変換します。 

     乗算値 

     加算値 

   線形範囲マッピング：Modbusからの入力値の範囲を設定します。 

     最小値：Modbus最大値設定  データポイント最大値設定 
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     最大値：Modbus最小値設定  データポイント最小値設定 

     クランプ：最小値  最大値 

   型変換：Modbusスレーブからの入力値をSigned、Unsigned、Float、Double型 

     にコンバートしてデータポイントへ渡します。 

 

  ⑤ 設定後 OK をクリックし、データポイントアドレス設定 画面を閉じます。 

  ⑥ 設定後 OK をクリックし、Modbusスレーブ設定 画面を閉じます。 

  ⑦ Modbus ドライバ設定 画面のリストに設定が追加されているのを確認し、適用 をクリックし 

   て下さい。ステータス が Running になることを確認して下さい。 
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１８．スクリプト 

 
 

 概 要 

DataHubの ビルドインスクリプトエンジン は、パワフルなプログラミング言語を提供しDataHub 

経由でデータ処理、加工、変更などを可能にします。 

 

 特徴 

 ・ポイント値が変更されるたびにスクリプトを実行させ、特定のデータポイントを監視し、データ処 

理をすることが可能です。 

 ・ロギングコードを定期的もしくは、ポイントに変更が発生した時にCSVやテキストファイルに 

  データを書き込みます。 

 

 詳細：https://cogentdatahub.com/features/customize/scripting/ 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propscripting.html 

 

スクリプト/カスタマイズ 

起動時に Gamma スクリプトファイル実行 

 

 

 

 

 

 

 

    ここでGammaスクリプトを追加することで、起動時に読み込むことが可能です。 

 

    新規：Gammaスクリプトファイルを新規登録することが可能です。 

追加：Gammaスクリプトファイルを追加することが可能です。 

    編集：Gammaスクリプトファイルを編集することが可能です。 

    実行：選択したGammaスクリプトを実行します。 

https://cogentdatahub.com/features/customize/scripting/
http://www.cogentdatahub.com/Docs/cdh-propscripting.html
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    削除：リストから選択したGammaスクリプトを削除します。 

    上へ移動・下へ移動：Gammaスクリプトの順番を変更します。 

 

                 クリックすると、スクリプトマネージャー画面が開きます。 

    実行中のスクリプトを確認、選択中止ボタンで停止させることが可能です。 

 

起動時に追加設定ファイル実行 

    起動時に実行するファイルを設定します。 

    DataHub起動時に、データドメインやデータポイントを追加する時などに使用します。 

 

 

 

 

 

 

    追加：設置ファイルを追加します。 

    削除：設定ファイルを削除します。 

    上へ移動・下へ移動：設定ファイルの順番を変更します。 

（ファイルは上から下へ読み込まれます。） 

 

ファイルの追加方法とファイルによるデータドメイン、データポイントの作成方法 

     起動時に実行するファイルの追加方法と、そのファイルでデータポイント、データドメイン 

     とデータドメインの初期値を設定する方法を記載します。 

 

     ① テキストエディタを開きます。 

     ② 作成したいデータドメイン名、データポイント名と初期値を下記のように記述します。 

データドメイン作成の記述方法 

             (create_domain データドメイン名) 

             例 (create_domain test) 

データポイント作成の記述方法 

    (cset データドメイン名:データポイント名 初期値(値) オプション) 

             例 (cset test:SineCopy 0 100) 

        このオプションの値は、自由に意味付けしてご使用いただけます。 

        0～100までの値を入力して下さい。何も入力しなければ100になります。 
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     ③ 名前を付けて .cfgファイル として保存します。  

     ④ 追加 をクリックし、③で保存した .cfgファイル を選択します。 

 

 

 

 

 

 

   

     ⑤ 適用 をクリックします。 

     ⑥ DataHubを終了し、再度起動させます。 

     ⑦ データブラウザでデータドメイン、データポイントが追加されていることを確認しま 

す。 
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１９．セキュリティ 

 
 

 概 要 

 ・DataHubはセキュリティ機能を内蔵していますので、ユーザ名やパスワード認証でデータや情報を 

  不正な侵入者から保護し安全性を確保します。 

 ・異種のプロトコル（OPC、DDE、TCP、Tunnel/Mirror（DataHubとDataHub間））への接続は 

  各コネクションでセキュリティ設定を行います。 

 ・個人ユーザ、グループユーザ毎に異なる権限を設定することが可能です。 

 

 ユーザ、パスワード、ユーザの権限の設定方法を記載します。 

 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-propsecurity.html（英文） 

 マニュアル：ユーザ容認 

http://www.cogentdatahub.com/Docs/cdh-securityauthentication.html（英文）  

 マニュアル：承認とユーザ権限 

http://www.cogentdatahub.com/Docs/cdh-securityauthorization.html（英文） 

  

 ビデオ：ユーザーログインの権限設定（英語） 

    http://www.cogentdatahub.com/Demos/UserPermissions/UserPermissions.html 

    日本語ビデオガイドの『４．ユーザーログインの権限設定』に記載されています。 

    グループユーザの設定方法も記載されています。 

 

 日本語ビデオガイド： 

http://www.cogentdatahub.com/Download/PDF_Release/Cogent_DataHub_JP_Video_Guide.p

df 

 

ユーザとグループ設定 

   ユーザ、パスワード、ユーザの権限の設定方法を記載します。 

 

 

http://www.cogentdatahub.com/Docs/cdh-propsecurity.html
http://www.cogentdatahub.com/Docs/cdh-securityauthentication.html
http://www.cogentdatahub.com/Docs/cdh-securityauthorization.html
http://www.cogentdatahub.com/Demos/UserPermissions/UserPermissions.html
http://www.cogentdatahub.com/Download/PDF_Release/Cogent_DataHub_JP_Video_Guide.pdf
http://www.cogentdatahub.com/Download/PDF_Release/Cogent_DataHub_JP_Video_Guide.pdf
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   許可設定をクリックします。 

 

   ユーザとユーザ権限の一覧を表示する管理画面が表示されます。 

 

 

 

 

 

 

 

 

 

 ユーザ名とパスワードの設定方法 

  ここでは、ユーザ名とパスワードの設定方法を記載します。 

   

  ① ユーザ を選択します。 

  ② UserName の一番下の欄をクリックし、新しいユーザ名 

    を入力します。 

  ③ Passwordをクリックすると「パスワードを編集」画面 

    が表示されます。 

  ④ パスワードを入力し、OKをクリックします。 

  ⑤ リストに追加されます。 

 

 

 

  ⑥ ログインユーザー数を制限する場合は、LoginCount 

    を設定して下さい。 

  ⑦ 次に、設定したユーザにユーザ権限を設定します。 

 

  



Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   143  

 ユーザ権限の設定方法 

  ここでは、ユーザ権限の設定方法を記載します。 

  オペレータやデザイナーなど担当毎に権限をグループ化しておくと権限の管理がしやすくなり 

ます。 

   設定例として オペレータ（Operator） と デザイナー（Designer）権限をグループ化します。 

  Operator：WebView画面を見るだけの権限 

  Designer：WebView画面を作成する権限 

 

  権限の設定 

    ① 権限をグループ化します。 

グループをクリックします。 

② GroupName の一番下の欄をクリックし、新しいグループ名を作成します。（例：Operator） 

 

 

 

 

 

 

  ③ Permissions （許可）で権限を選択します。 

    オペレータ権限の設定 

    【 Connection：接続許可 】Connect 

    【 Data：データへの権限 】Read、Write 

    【 Restrictions：規制 】設定しない 

    【 HTTP：HTTP接続 】Connect 

    【 WebView：WebViewへの権限設定 】 BrowseInternet、Connect、 

     ViewOtherOwerPage、ViewPage 
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    デザイナー権限の設定 

    【 WebView：WebViewへの権限設定 】 WebView に関するパラメータの全てに 

     チェックする。 

 

 

 

 

 

 

 

 

 ユーザごとに権限の設定 

   ① ユーザに権限を設定します。 

    オペレータ設定 

 

 

 

 

 

 

 

 

 

    デザイナー設定 

 

 

 

 

 

 

 

  ② 権限を選択後、画面右下の 適用と閉じる をクリックし、設定を適用させて画面を閉じます。 

  ③ グループ メンバーシップに設定 

    したグループのGroupNameが追加 

    されます。 
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 リストから設定を削除する方法 

  ① 削除したい UserName をクリックします。 

  ② Delete を押します。 

  ③ 「ユーザを削除」画面が表示されます。 

    OK をクリックします。 

  ④ ユーザリストから削除されたことを確認します。 
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２０．ライセンス 

 
 

 ライセンスの設定方法を記載します。 

 

 マニュアル：http://www.cogentdatahub.com/Docs/cdh-proplicenses.html（英文） 

 

ライセンス設定 

 

 

 

 

 

 

 

 

 

 

  TCPリンクライセンス：DataHubへ接続するには、TCPライセンスが必要です。 

（トンネル/ミラーマスタは除く）APIによる接続も必要です。 

    使用中：TCP接続数 

    有効：現在の有効ライセンス数 

    合計：ライセンス数 

    最大：現在のセッション開始からの最大接続数 

  WebViewクライアントライセンス：WebViewへのアクセスライセンス 

    使用中：WebViewクライアント接続数 

    有効：現在の有効ライセンス数 

    合計：ライセンス数 

    最大：現在のセッション開始からの最大接続数   

  ノードライセンス：現在のDataHub無制限ライセンス契約状態 

    無制限TCPリンクライセンス：無制限TCPリンクライセンスの有無 

    無制限DDEライセンス：無制限DDEライセンスの有無 

    無制限トンネリング/ミラーリング：無制限トンネル/ミラーリング接続ライセンスの有無 

    無制限OPCライセンス：無制限OPCライセンスの有無 

http://www.cogentdatahub.com/Docs/cdh-proplicenses.html
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詳細 

    ここには、入力されたライセンスが表示されます。 

 

 

 

 

 

 

 

 

 

 

   

    無許可機能アイコンを表示しない：ライセンス切れのものは表示しません。 

    無効ライセンスを表示しない：未使用のライセンスを表示しません。 

    ライセンス番号：ここをクリックするとライセンス番号を入力する画面が出力されます。 

 

 

 

 

 

 

 

 

    ライセンスファイル実行：ライセンスファイルを選択して実行します。 

    ライセンス削除：システムからライセンスを削除します。   
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 第 3 章 

Cogent DataHubⓇ 

H M I 作 成 ガ イ ド 

   

 

    Cogent DataHub® のWebブラウザ上のHMI（Human Machine Interface）作成機能である  

    DataHub® WebView™の基本操作からHMI作成までが記載された、HMI作成ガイドです。 
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はじめる前に 

１．WebView とは 

 Cogent DataHub（以下DataHubと記載します）へ接続されたデータをWebブラウザ上に高速表示 

 させる、DataHubのデータ表示機能の一つです。 

 グラフやゲージなどのコントロール･パーツを使ってグラフィカルなＨＭＩを描くことが可能です。 

 Webブラウザでどこからでも見ることができるだけではなく、編集することも可能です。 

 

２．データについて  

http://www.cogentdatahub.com/Docs/cdh-workingwithdata.html（英文） 

 

  ２.1. データドメインとデータポイント 

    DataHubでは、機器、異なるシステム、DataHubの機能、カスタムプログラム等の接続 

    データなどをデータドメイン名とデータポイント名により識別させることが可能です。 

     （例） DataPid:PID1.Mv  赤字：データドメイン 青字：データポイント 

 

   ２.１.1. データドメイン 

     DataHubに接続されているデータ構造最上位の名称。 

 

   ２.1.２. データポイント 

     データドメインでグループ分けされた識別データ名であり、下記属性が含まれます。 

     ・名前：文字列 

     ・値：整数、浮動小数点、文字列 

     ・時間：データポイントの値、品質、信頼性または、その他のステータスが変更された 

        最終日時 

     ・品質：DataHubによって割り当てられた接続状態  

     ・タイプ：データのタイプ 

     ・その他：自由に意味づけして使用可能な、0～100までの値 

 

  ２.２．シミュレーションデータ 

    DataHubへ接続する評価用のシミュレーションデータが準備されています。 

http://www.cogentdatahub.com/Docs/cdh-workingwithdata.html
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    ご使用の際は、DataHubを起動させた後、ダブルクリックで起動させて下さい。 

 

 

  

 

   ２.２.1. DataSim™：波形データ 

     http://www.cogentdatahub.com/Docs/cdh-datasim.html  

     SIN：正弦波のデータを生成（データポイント名：DataSim:Sine） 

     SQR：方形波のデータを生成（データポイント名：DataSim:Square） 

     TRI：三角波（45度）のデータを生成（データポイント名：DataSim:Triangle） 

 

   ２.２.２. DataPid™：PIDのシミュレーションデータ 

     http://www.cogentdatahub.com/Docs/cdh-datapid.html  

     SP：目標値（データポイント名：DataPid:PID1.Sp） 

     MV：制御量（データポイント名：DataPid:PID1.Mv） 

     PV：偏差値（データポイント名：DataPid:PID1.Pv） 

 

 

３．環境の設定 

  

 WebViewで画面作成する際に使用するWebブラウザは、IE（Internet Explorer）をお勧めします。 

 

  ３.１．Internet Explorer の設定 

   

    マニュアル：http://www.cogentdatahub.com/Docs/wv-configuration.html（英文） 

 

   ３.１.１. PCからの設定（Windows 7 の場合） 

     ① スタート・メニュー → コントロールパネル → ネットワークとインターネット →  

          インターネットオプション を選択します。 

     ② インターネットオプション 画面が表示されますので、 

      全般 → 閲覧の履歴 の 設定 をクリックします。 

     ③ Webサイトデータの設定 画面が表示されますので、 

      インターネット一時ファイル → 保存しているページの新しいバージョンがあるかどうか 

      の確認：→ Webサイトを表示するたびに確認する を選択します 

 

http://www.cogentdatahub.com/Docs/cdh-datasim.html
http://www.cogentdatahub.com/Docs/cdh-datapid.html
http://www.cogentdatahub.com/Docs/wv-configuration.html
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   ３.１.２. Internet Explorer からの設定 

     ① IE を起動させます。 

     ② 画面右上の歯車（ツール）をクリックし、インターネットオプションを選択します。 

     ③ あとは、３.１.１. PCからの設定 と同じです。 
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WebView 基本操作 

１．データドメインの設定 

   WebViewからアクセスできるデータドメインを設定します。 

 

  １.１．データドメインの追加 

    ① リフレッシュをクリックすると、DataHubに接続されているデータドメインのリストが 

     表示されます。チェックを入れて使用するデータのドメインを選択します。 

    ② 新しいドメインを作成するには、 追加 を クリック します。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

    ③ データドメイン名 を入力し、OK を クリック します。 

 

 

 

 

 

    ④ データドメイン に入力した データドメイン名 が追加されますので、チェック をいれ 

     ます。 

 

 

 

 

 

 

    ⑤ 設定後は、適用 をクリックして設定を反映させて下さい。 
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２．WebView の起動と終了 

  ２.１．WebView起動方法 

    WebViewの起動方法は ２ とおりあります。 

 

   ２.1.1. DataHubからの起動 

     ① DataHubを起動し、WebViewを選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

        ② 起動ページ実行 プルダウンリストから、起動ページを選択します。 

     ③ ブラウザ上でWebView起動 をクリックします。 
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     ④ UserName と Password を入力し、Connect をクリックします。 

      デフォルトは、UserName：admin 、Password：admin です。 

     ⑤ WebViewが起動しました。（デザインモード） 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

     ２.1.2. ブラウザからの起動 

     ① ブラウザに DataHub が起動しているコンピュータの WebView のURLを直接入力し 

      ます。 

      (例) 

      Webサーバの基本設定のポート：80を使用する場合 

 （SSLを使用するにチェックを入れない） 

 http://192.168.3.20/Silverlight/DataHubWebView.asp 

        http://localhost/Silverlight/DataHubWebView.asp 

      赤枠の箇所がIPアドレスもしくは、ホストコンピュータ名になります。 

 

      Webサーバのポート番号を8080に変更した場合は 

        http://192.168.3.20:8080/Silverlight/DataHubWebView.asp 

 

      Webサーバの基本設定でSSLを使用にチェックを入れた場合 

        https://192.168.3.20/Silverlight/DataHubWebView.asp 
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     ② 以降の手順は「２.1.1. DataHubからの起動」と同じです。 

 

  ２.２．WebView終了方法 

    WebViewは、ブラウザの画面右上の「×」をクリックしてブラウザを閉じることで終了し 

    ます。この時に「このページから移動しますか？」等の警告メッセージが出力されます。 

    編集中の保存ページがないことを確認して「OK」または「このページから移動」をクリックし 

    ます。 

 ※使用ブラウザによってメッセージ内容は異なります。 
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３．ランモードとデザインモード 

  WebViewの画面には、ランモードとデザインモードがあります。 

 

 

 

 

 

 

 

 

 

 

         ランモード                  デザインモード 

  ３.１．ランモード 

    オペレータやエンドユーザが使用する画面モードです。 

    ランモードには、他にキオスクモードがあります。 

 

   ３.1.１. キオスクモード 

     キオスクモードとは、エンドユーザへ提供するランモードです。誤作動防止の為、メニュー 

     バーやツールバーが表示されません。 

 

 

 

   

        通常のランモード               キオスクモード 

 

  ３.２．デザインモード 

    WebViewページを作成・編集可能な画面モードです。 

 

  ３.3．ランモードとデザインモードの切り替え 

       ランモードからデザインモードへ切り替わります。 

       デザインモードからランモードへ切り替わります。 

    「 Ctrl + Shift + R 」のキーを同時に押すと、ランモード ⇔ デザインモードが切り替わり 

    ます。 

メニューバー 
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４．デザインモードの画面説明 

  ４.1．デザインモードの画面の名称 

    メニューバー 

     画面上部にメニューバーがあります。 

       

 

    キャンパス 

     ページの右側Webページを作成するキャンパスです。（ハイライト部分） 

   

 

 

 

 

 

 

    コントロール・アイコン 

     画面下部にはコントロール・アイコンがあります。（ハイライト部分） 

     コントロール・アイコンをクリックすると、画面にコントロール・パーツが挿入されます。 

 

 

 

 

 

 

 

    プロパティ 

     画面左側はページやコントロール・パーツのプロパティです。（ハイライト部分） 
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５．WebView 画面の新規作成と保存 

   新規作成、保存、保存画面の表示について説明します。 

 

  ５.１．新規作成 

     ① メニューより File → New を選択するか、   をクリックして下さい。 

     ② 無地のキャンパスが表示されます。 

       ここにコントロールを使って画面を作成します。 

 

  ５.2．保存 

   ５.２.１. 名前をつけて保存 

     ① メニューより Save as... を選択して下さい。 

     ② Filename にファイル名を入力し、OKをクリックします。 

 

 

 

 

 

 

 

 

 

     ③ Pages のリストに追加されていることを確認して下さい。 

 

 

 

 

 

  

   ５.２.２. 上書き保存 

     メニューより File → Save を選択するか、   をクリックして下さい。 

 

  ５.3．保存画面の表示 

    保存した画面を呼び出します。 

    Pages から呼び出したいファイル名を選択して下さい。 
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６．リフレッシュ 

   オブジェクトをリフレッシュすることが可能です。 

   メニューバーの Tools → Diagnostics → Refresh Application Objects 

 

 

７．WebView 作成画面データについて 

   WebViewで作成された画面は、.xml ファイルで下記場所に保存されています。 

 

   【64ビットCPUの場合】 

   C:¥Program Files (x86)¥Cogent¥Cogent DataHub¥Plugin¥WebServer¥html¥Silverlight 

   ¥Pages¥Users¥admin 

   【32ビットCPUの場合】 

   C:¥Program Files¥Cogent¥Cogent DataHub¥Plugin¥WebServer¥html¥Silverlight 

   ¥Pages¥Users¥admin 

 

   ※DataHubをインストール後、一度もWebView画面を保存されていない場合は、赤字部分の 

    フォルダはありません。 

 

   Pages 以下にフォルダを作成して .xmlファイルを保存することが出来ます。 

   保存後、メニューバーの Tools → Diagnostics → Refresh Application Objects 

                     をクリックして構成をリフレッシュして下さい。 

   Pages のリストに .xmlファイルを反映させることが可能です。 

 

   この .xml ファイルにコントロールやスクリプトの情報が書かれています。 

   他のコンピュータにこのファイルを保存して、WebViewでアクセスすると同じ画面を見ること 

   が可能です。 

 

８．WebView マニュアル 

   メニューバーの Help → View Help をクリックして下さい。 

   WebViewマニュアル：https://cogentdatahub.com/docs/#wv-book.html（英文） 

 

 

https://cogentdatahub.com/docs/#wv-book.html
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HMI（Human Machine Interface）の基本作成 

１．キャンパスの設定 

   画面を新規作成すると、新しいキャンパスが表示されます。 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  １.１．キャンパスのサイズ設定 

    ① 画面右下の赤枠のところに直接値を入力します。 

    ② もしくは、Properties の Canvas → Width、Height に値を入力します。 

 

  １.２．キャンパスのデザイン変更 

   １.２.１. バックグラウンドのカラー変更 

      ① Properties の Canvas → Background にてバックグラウンドの色を変更することが 

     可能です。輝度の変更も可能です。 

 

 

 

 

 

 

 

 

 

輝度の変更 
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   １.２.2. バックグラウンドイメージの変更 

       ① Properties の Canvas → Background Image をクリックします。 

 

 

 

       ② ドロップダウンリストから画像を選択してクリックします。 

 

   １.２.３. オリジナルイメージの挿入 

     オリジナルのイメージをキャンパスに表示することが可能です。 

     ① 下記フォルダ内にオリジナルファイルを作成して保存します。 

    【64ビットCPUの場合】 

    C:\Program Files (x86)\Cogent\Cogent DataHub\Plugin\WebServer\html\Silverlight 

    \Images 

    【32ビットCPUの場合】 

    C:\Program Files\Cogent\Cogent DataHub\Plugin\WebServer\html\Silverlight 

       \Images 

    ※Cogent DataHubをインストールする際に保存先を変更しなかった場合 

     ② メニューバーの Tools → Diagnostics → Refresh Application Objects 

                                             をクリックして構成をリフレッシュして下さい。 

     ③ Properties の Canvas → Background Image のドロップダウンリストに追加されま 

     す。 

 

２．バインディング 

   コントロール・パーツのプロパティにDataHubのデータポイントや他のコントロール・パーツの 

   プロパティをバインド（結合）します。 

 

 ２.１．バインディングの種類 

    None：値や文字列を直接入力します。 

    Point：データポイントをバインドします。 

    Simple：コントロールのプロパティ同士をバインドします。 

    Script：スクリプトを挿入します。 

 

    ※コントロールをトリガに1度だけの処理をScriptで記載する場合は、Noneに記載します。 

     例えば、ボタンコントロールがクリックされた時に1度だけ処理するなど。 
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   ２.１.１．データポイントバインディング 

     Circular Gauge 2 と Text Label にデータポイントをバインドします。 

     ① コントロール・アイコンから Circular Gauge 2 と Text Label をクリックします。 

 

   

 

 

 

 

 

   

 

    ② Text Label をクリックで選択します。 

    ③ Properties の Basic Properties → Input Value で Point を選択します。 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

     ④ バインドしたいデータポイントを設定します。 

     データドメイン名、データポイント名の一部を入力するだけで、候補が表示されます。 

     ここでは、DataPid:PID.Mvを設定します。 

 

  

 

 

Circular Gauge 

Text Label 
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    ⑤ データポイント DataPid:PID1.Mv が Text Label にバインドされました。 

 

 

 

    ⑥ 同じく、Circular Gauge 2 にもデータポイントをバインドします。 

     Circular Gauge 2 をクリックで選択します。 

    ⑦ Properties の Basic Properties → Current Value で Point を選択します。 

    ⑧ バインドしたいデータポイントを設定します。ここでは、DataPid:PID1.Mv を設定しま 

    す。 

    ⑨ データポイント DataPid:PID1.Mv が Circular Gauge 2 にバインドされました。 

 

   

 

 

 

 

 

  

 

   ２.１.２．Simpleバインディング   

    ２.１.２.２．コピー & ペースト を使用する方法 

      Simpleバインディングのもう一つの方法は、参照コントロールのプロパティのリンクを 

      コピーして、リンク先のコントロールのプロパティに貼り付ける方法です。 

 

      六角形の Simple Path１ を参照コントロールとし、四角形の Simple Rectangle１  

      へコントロールのプロパティをリンクします。 

 

 

 

 

 

 

 

 

 

 

Simple Path１ 
Simple Rectangle１ 
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    ① コントロール・アイコンから Simple Path と Simple Rectangle を準備します。 

    ② Simple Path をクリックし、Properties の Basic Properties → Fill Color に Orange 

     を選択します。 

 

    【Simple Path の Fill Color プロパティの値を Simple Rectangle の Fill Color プロパティ 

     の値にコピー ＆ ペーストを使用してバインディング】 

    ③ Simple Path をクリックし、Properties の Basic Properties → Fill Color 上にカーソル 

     を当て、マウスを右クリックします。 

    ④ リストボックスが表示されますので、Copy Reference を選択します。 

 

 

 

 

 

 

 

 

 

 

    ⑤ 最初の１回は、下記のメッセージが表示されます。はい を選択してください。 

 

 

 

 

 

 

 

 

 

    ⑥ Simple Rectangle をクリックし、Properties の Basic Properties → Fill Color 上に 

     カーソルを当て、マウスを右クリックします。 

    ⑦ リストボックスが表示されますので、Paste Link を選択します。 
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    ⑧ Simple Path の Fill Color プロパティの値を Simple Rectangle の Fill Color  

     プロパティの値にバインドできました。 

 

 

 

 

 

 

 

 

 

 

    ⑨ Simple Path をクリックし、Properties の Line Properties → Stroke Thickness の値 

に５ を設定します。下記の図のように図形の輪郭が太くなります 

     Stroke Thickness は、図形の輪郭の幅を設定します。 
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    【Simple Path の Stroke Thickness プロパティの値を Simple Rectangle の Stroke 

   Thickness プロパティの値にコピー ＆ ペーストを使用してバインディング】 

    ⑩ Simple Path をクリックし、Properties の Line Properties → Stroke Thickness 上に 

     カーソルを当て、マウスを右クリックします。 

    ⑪ リストボックスが表示されますので、Copy Reference を選択します。 

 

 

 

 

 

 

 

 

 

 

    ⑫ Simple Rectangle をクリックし、Properties の Basic Properties → Stroke Thickness 

     上にカーソルを当て、マウスを右クリックします。 

    ⑬ リストボックスが表示されますので、Paste Link を選択します。 

 

 

 

 

 

 

 

 

   ⑭ Simple Path の Stroke Thickness プロパティの値を Simple Rectangle の Stroke  

     Thickness プロパティの値にバインドできました。 
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 ２.２．データポイントの属性の選択 

   これらは、テキスト入力欄の右側にある矢印を右クリックするとデータポイントの属性を設定 

   することが出来ます。 

ドロップダウンメニューから選択が可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

メニュー項目 ポイント属性 例 

 フルポイント名（ドメインなし） PID1.Pv 

 省略されたポイント名 Pv 

 フルネーム（ドメイン名含む） DataPid:PID1.Pv 

 クオリティ Good 

 クオリティコード 192 

 日付&時刻 09/02/2014 13:00:00 

 ポイント値 71.3347689 

 ポイント値、クオリティ、タイムスタンプ 71.334{Good,13:09:15.32} 
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３．コントロール･パーツの配置 

  3.1．グループ化と解除 

   3.１.１．グループ化 

     コントロール･パーツをグループ化します。 

     ① グループ化するコントロール･パーツを Shift を押しながらマウスでクリックし選択する  

      もしくは、マウスのクリック＆ドラッグでコントロール･パーツを囲い込んで選択して下さ 

          い。 

 

 

 

 

 

 

 

 

 

    ② メニューから    をクリックする。もしくは、 

      メニューの Format → Arrange → Group を選択します。 

      マウスの右クリックでポップアップメニューを表示させ、選択することも可能です。 

     ③ コントロール･パーツのグループが作成され、グループ名が付けられます。 

 

 

 

 

 

 

 

   3.１.２．グループ化解除 

     グループ化されたコントロール･パーツを解除します。 

     ① グループを選択します。 

     ② メニューから      をクリックします。もしくは、 

      メニューの Format → Arrange → Ungroup を選択します。 

      マウスの右クリックでポップアップメニューを表示させ、選択することも可能です。 

     ③ グループ名はなくなります。 
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   3.１.3．グループ内の任意のコントロールのプロパティ変更 

     グループ化された状態で、各コントロール･パーツのプロパティを変更することが可能で 

     す。 

    ① グループを選択します。 

    ② Properties の Children → Children にグループに所属するコントロール･パーツが表示 

         されます。変更したいコントロール･パーツを選択します。ここでは、SimpleRadialGauge1 

         を選択します。 

 

 

 

 

 

 

 

 

 

 

 

    ③ Properties の Children → Select Child をクリックします。 

 

 

 

 

 

 

 

 

 

    ④ Children で選択したコントロール･パーツのプロパティの変更が可能になります。 

 

  3.2．コントロールの移動 

    マウスでコントロール･パーツをクリック、ドラッグして移動させる方法以外に、カーソルキ 

    ー（←、↑、↓、→）を使って位置を移動する方法があります。 

    ・1ピクセルごとに移動させる： Ctrlキー + カーソルキー 

    ・10ピクセルごとに移動させる： カーソルキー 

    ・100ピクセルごとに移動させる： Ctrlキー + Shiftキー ＋ カーソルキー 
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  3.3．コントロールの配置 

    コントロール･パーツの配置を設定します。 

 

   3.3.1．前へ配置 

     ・   コントロール･パーツを一番前に配置 

     ・   コントロール･パーツを一つ前に配置 

 
 
                              
 
 
 
 
 
 
 
 
 
 
 

   3.3.2．後ろへ配置 

     ・   コントロール･パーツを一番後ろに配置 

     ・   コントロール･パーツを一つ後ろに配置 

 

  3.4．コントロールの名前の変更 

    コントロール、グループ化されたコントロールに任意の名前を付けることが可能です。 

 

 

 

 

 

 

 

     ① 名前を変更したいコントロール･パーツをクリックで選択します。 

     ② Properties の Name に任意の名前を入力後、Enter で確定します。 

          名前は固有でなければなりません。 

 

  3.５．コントロールの拡大と縮小 

    コントロール･パーツは、クリックで選択し、縦、横、斜めにパーツの大きさを拡大縮小する 

       ことが可能です。 
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  3.６．コントロールのコピーと貼り付け 

    コントロール･パーツは、コピー、貼り付けすることが可能です。その際、コントロール･ 

    パーツのプロパティの設定も一緒にコピーされます。 

    グループ化されたコントロール･パーツもグループごとコピー、貼り付けすることが可能で 

    す。 

 

   3.6.1．コントロールのコピー 

     ① クリックでコピーするコントロール･パーツを選択します。 

     ② メニューから      をクリックします。もしくは、 

      メニューの Edit → Copy を選択します。 

      マウスの右クリックでポップアップメニューを表示させ、Copyを選択することも可能で 

      す。 

      PCのキーボードショートカット操作 『 Ctrl + C 』 で選択することも可能です。 

 

   3.6.２．コントロールの貼り付け 

     ① メニューから      をクリックします。もしくは、 

      メニューの Edit → Paste を選択します。 

      マウスの右クリックでポップアップメニューを表示させ、Pasteを選択することも可能で 

      す。 

       PCのキーボードショートカット操作 『 Ctrl + V 』 で貼り付けすることも可能です。 
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４．コントロール・パーツの使い方 

  コントロール･パーツの使い方を記載します。 

  各コントロール･パーツの説明： 

    http://www.cogentdatahub.com/Docs/rs-wv-selectedcontrols.html 

 

  4.1．Table と Charts 

   4.１.1．FilteredDataTable 

     データをテーブル形式で表示します。 

     DataHubのデータロギング機能と連携させることで、データベースのデータを表示すること 

     が可能です。 

 

     ① 『Cogent DataHub® Ｍ2Ｍ設定ガイド』DataHubのデータロギング機能の「データ 

       ロギングの設定方法」、「ODBCデータベースクエリー設定」を参照し、データベースの 

           リード、ライトを設定して下さい。 

     ② コントロール・アイコンの FilteredDataTable をクリックし、コントロール・パーツを 

      表示します。 

     ③ Properties の Basic Properties → Items Source でPointを選択し、クエリー設定で 

      作成したデータポイントを選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.cogentdatahub.com/Docs/rs-wv-selectedcontrols.html
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   4.1.2．PointDataTable 

     DataHubに接続されているデータポイントを表示します。 

 

 
 
 
 

 

 

   4.1.3．SeriesChart 

     グラフ形式でデータを表示します。 

     DataHubのデータロギング機能と連携させることで、データベースのデータを表示すること 

     が可能です。 

 

 

 

 

 

 

 

 

   4.1.4．Trend Chart（TrendChart3pens または TrendChart8pens） 

     データの動向を時間ともにグラフで見ることが可能です。 

     さらにDataHubのヒストリアン機能と連携させることで、データの履歴を見ることも可能で 

     す。 

    ① 『Cogent DataHub® M2M設定ガイド』DataHubのヒストリアン機能を参照して、 

          ヒストリアンを設定します。 

    ② WebView を起動させ、ページを新規作成します。 

    ③ Trend Chartをクリックします。（ここでは TrendChart3pens を使用します） 

    ④ Properties の Basic Properties → Pen 1 Value のPointを選択します。 
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    ⑤ Pen 1 Value にデータポイント：DataPid:PID.Pv を設定します。 

 

 

 

    ⑥ Pen 2 Value にDataPid:PID.Mv、Pen 3 Value にDataPid:PID.Sp をそれぞれ設定し 

         ます。 

    ⑦ 閾値イメージのラインを描きます。 

     Pen 4 Value の Binding：None を選択し、Value に 25 を入力します。 

         同じく Pen 5 Value の Binding：None を選択し、Value に 75 を入力します。 

       ⑧ Properties の Pen 4 Properties → Pen 4 Is Constant にチェックを入れます。 

     ここにチェックを入れることで一定の値のラインが表示されます。 

     Pen 5 Is Constant も同じく設定します。 

    ⑨ Properties の Pen 4 Properties → Pen 4 Color を設定します。 

     ここでは、Gray を設定します。 

     Pen 5 Color にも同じく設定します。 

    ⑩ Properties の Chart Properties → Show Timer Span Picker にチェックを入れると、 

     下記コントロールが表示されます。過去の履歴を見る時に使用します。 

 

 

    ⑪ Properties の Chart Legend Properties → Show Pen Visibility Selection にチェック 

     を入れると、チェックボックスが表示されます。チェックを外すとその波形のみチャートか 

         ら                非表示にすることが可能です。このようにしておくことで、見たい 

              時に見たい波形のみを表示することが可能です。 

     ⑫ ランモードで実行します。   をクリックして下さい。 

 

 

 

 

 

 

 

 

 

 

 

    ⑬ ヒストリアン機能と連携することで、データの履歴を確認することが可能です。 

過去 参照したい日時を設定 現在 
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  4.２．ListBox と ComboBox の使い方  

      ListBox と ComboBox のリストからデータを選択し、Trend Chart にデータを表示する。 

 

 

 

 

 

 

 

 ① ListBox と ComboBox と Trend Chart コントロール･パーツをキャンパスに準備します。 

   ② ListBoxをクリックで選択します。 

   ③ Properties の Basic Properties → Items Source で Script を選択し、リスト項目を設定 

       します。 

    設定には、下記 Script を記入します。 

 

  

 

 

 

 

 

 

   ④ 設定後      をクリックします。 

   ⑤ 同じように、ComboBox にもリスト項目を設定します。  

   ⑥ TrendChart をクリックで選択します。 

ComboBox1 

ListBox1 

TrndChart3Pens1 / TrendChart8Pens1 
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   ⑦ Properties の Basic Properties → Pen 1 Value で Point を選択し、下記のように記入 

       します。Pen 2 Value も下記のように記入します。 

       =“DataPid:PID1.”+GETP(“ComboBox1@SelectedValue”); 

       =“DataPid:PID1.”+GETP(“ListBox1@SelectedValue”); 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   ⑧ ランモードで実行します。   をクリックして下さい。 

   ⑨ ListBox、ComboBox の値を選択し、Trend Chart に値が反映されることを確認して下さ 

    い。 
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  4.３．Symbol 

   4.３.１．Symbol の使い方 

     Symbolの設定方法を記載します。 

 

     Symbolでタンクの絵を描く。 

 

 

 

 

  

    準備するコントロール･パーツ 

 

   Symbol１：    をクリック後、Symbol Selection → Symbol Set →「Symbol Factory」 

                  を選択します。 

         Symbol Selection → Category →「Tanks」を選択します。 

          Symbol Selection → Symbol →「Tank5」を選択します。  

 

  

 

 

   Progress Bar：   をクリックします。 

 

   Symbol２：   をクリック後、Symbol Selection → Symbol Set →「Symbol Factory」 

                  を選択します。 

         Symbol Selection → Category →「Water & Wastewater」を選択します。 

          Symbol Selection → Symbol →「Clarifier 4」を選択します。 

 

 

 

 

 Symbol３：   をクリック後、Symbol Selection → Symbol Set →「Symbol Factory」を 

       選択します。 

Symbol1 

Symbol２ 

Symbol３ 

ProgressBar 
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       Symbol Selection → Category →「Tank Cutaways」を選択します。 

         Symbol Selection → Symbol →「Triangular cut-away」を選択します。 

 

 

 

  

  

   タンクの水位をデータポイントで可変にする。 

   タンク１の水位によって、水の色を可変にする。 

   タンク２に数量を表示する。また水量は小数点第２位までを表示する。 

 

 

 

 

 

 

 

  

    【タンク１の設定】 

    ① Progress Bar をクリックで選択します。 

    ② Properties の Basic Properties → Input Value で Point を選択します。 

    ③ ここでは、DataPid:PID1.Pvをとバインドします。 

    ④ Properties の ColorVariation を下記内容に設定します。 

        （色が変更する閾値となります。） 

     Maximum～80Red、80<～60までDarkOrange、60<～40までLime、40<～20まで 

     Blue、20<～MinimumまでTurquoise にします。 

 

 

 

 

 

 

 

 

 

 

タンク１ タンク２ 

TextLavel 

Symbol1 

Symbol２ 

Symbol３ 
ProgressBar 
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    ⑤ Properties の Color Variation → Fill Colors Enabled にチェックを入れます。 

     ここにチャックを入れることで、Fill Color が有効になります。 

        （値により色が変更されます） 

    ⑥ ランモードで実行して下さい。   をクリックして下さい。 

     値によって水の色が変更されていればOKです。 

 

    【タンク２の設定】 

    ① Symbol３をクリックで選択します。 

    ② Properties の Progress → Progress Value で Point を選択します。 

    ③ ここでは、DataPid:PID1.Pv をバインドします。 

    ④ Properties → Progress → Progress Color を設定します。（色は自由に設定して下 

     さい） 

    ⑤ Properties → Progress → Progress Color Minimum、Maximumを設定します。 

 水位の範囲を設定します。ここでは、0、100と入力して下さい。 

    ⑥ Properties → Progress → Is Showing Progress にチェックを入れます。 

     ここにチェックを入れることにより、値によって水位が変化します。 

    ⑦ Properties → Aesthetics → Accent Color2 を Silver にします。 

    ⑧ コントロール・アイコンから Text Label をクリックして追加します。 

    ⑨ Properties → Basic Properties → Input Value で Point を選択します。 

  ⑩ ここでは、DataPid:PID1.Pv をバインドします。 

    ⑪ Properties → Basic Properties → Format String に直接フォーマットを入力します。 

     ここでは 00.00 と入力します。 

 

 

 

 

       このマークをクリックすると、説明書きが表示されます。 

 

 

    

 

 

 

 

 

 



Cogent DataHub® 入門ガイド 

    

S021601-001-120 2019/1/6   180  

    ⑫ ランモードで実行して下さい。   をクリックして下さい。 

   4.３.２．Symbol の探し方 

     イメージ通りの Symbol をリストからクリックして探すのはとても大変です。  

     デモサンプルに Symbol を複数一度に見ることができるページ「Symbol Gallery」があり 

     ます。 

     Pages タブをクリックし、Cogent ⇒ Symbol Gallery を選択してください。 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    ランモードで実行して下さい。 

    デモサンプルは、デザインやScriptを学習するのにとても有効です。 
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  4.４．WebView上で計算する方法 

    Two-Input Calculator の使い方 

 

    WebView上で割り算する方法は、２ 種類あります。 

 

 

 

 

 

   

    このデータポイント（ポイント名：input）を1000で割り算します。 

    ボタンをクリック時に、その結果をデータポイントに出力します。 

 

   4.４.１．Two-Input Calculator の使い方 

    ① コントロール・アイコンから Two-Input Calculator と Simple Button をクリックし 

ます。 

    ② Two-Input Calculator をクリック選択します。 

    ③ Properties の Inputs → Input 1 で Point を選択し、分子とするデータポイントを 

         バインドします。 

    ④ Properties の Inputs → Input 2 で 分母となる値 1000 を入力します。 

    ⑤ Quotient（割り算）に割り算結果が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

    ⑥ 割り算結果をデータポイントに出力する方法として、WebView Script の SET メソッド 

     を使います。 

Two-Input Calculator 

Simple Button1 

Simple Button

２ 
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    ⑦ Properties の Custom Event → OnClick で None を選択し、下記スクリプトを記載し 

         ます。 

     このプロパティは、マウスをクリックされた時のみに実行されるイベントです。 

     SET(“test:output1”,GETP(“TwoInputCalculator1@Quotient”)); 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    ⑧     をクリックし、エラーが出力されなければ、Apply をクリックします。 

    ⑨ ランモードで実行し、Simple Button1クリック後、データブラウザ上で計算結果 

        （output1）が 0.8 になることを確認します。 

 

   4.４.２．スクリプトで計算式を作成する方法 

    ① コントロール・アイコンから Simple Button をクリックします。 

    ② Properties の Custom Event → OnClick で None を選択し、下記スクリプトを記載し 

         ます。 

     このプロパティは、マウスをクリックされた時のみ実行されるイベントです。 

     通常 String で受けた “0800” は割り算できませんので、Convert.ToInt32()で数値化し 

         ます。 

     また、Int 型同士の計算では小数点以下の計算が出来ませんので 1000.00 で割ります。 

 

     var val = Convert.ToInt32(VAL(“test:input”))/1000.00; 

        SET(“test:output2”,val); 
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    ③      をクリックし、エラーが出力されなければ、Apply をクリックします。 

    ④ ランモードで実行し、Simple Button2クリック後、データブラウザ上で計算結果 

        （output2）が 0.8 になることを確認します。 

 

 

 

 

 

  



Cogent DataHub® 入門ガイド 

    

S021601-001-120 2019/1/6   184  

  4.５．ラジオボタンの使い方 

     ラジオボタンの使い方を記載します。 

   

 ラジオボタンは、いくつかのラジオボタンをグループとし、グループの中で選択されたラジオ 

 ボタンの出力値を制御などに使用します。 

 

 Radio Button のプロパティ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Propertys Name Value 説明 

Basic Properties InputValue 10 選択された時に OutputValue

が反映する。 

OutputValue 10 選択された時の出力値 

IsChecked ☑ ☑：選択された状態 

Text Value=10 表示したい文字列または数値 

IsEnable ☑ ☑：コントロールが有効 

RadioGroup Radio1 グループ名 

グループ名でグループわけさ

れる。 

 

  



Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   185  

   4.５.1．ラジオボタンで値を選択する 

    ここでは、ラジオボタンを選択し、ラジオボタンの 

    出力値をテキストラベルに表示する方法を記載します。 

 

    ① コントロール・パーツから Radio Button を３つ 

     と Text Label を２つ準備します。 

    ② Radio Button をクリックで選択し、Properties の Basic Properties → Text に 

         各Radio Buttonのラベルに表示したい文字を入力します。 

     ここでは、Value=10、Value=20、Value=30を入力します。 

    ③ Properties の Basic Properties → OutputValue に各Radio Buttonに10、20、30を 

         入力します。 

     この OutputValue の値は、ラジオボタンがチェックされた時の出力値となります。 

    ④ 次にラジオボタンの出力値を Text Label1 に表示されるように設定します。 

        ラジオボタンをクリックで選択し、Properties の Basic Properties → InputValue で 

     Simple を選択します。  

    ⑤    をクリックし、バインドしたいコントロール･パーツをクリックします。 

     ここでは、TaxtLabel1 をクリックします。 

    ⑥ TextLabel１ のプロパティが表示されますので、バインドしたいプロパティを選択します。 

     ここでは、Basic Properties → Input を選択します。（各Radio Buttonに行います） 

    ⑦ 残りの TextLabel２ の Properties の Basic Properties → Input に } を入力します。 

     Properties の Font and Alignment → FontSize（フォントサイズ）と FontFamily 

    （フォント）を設定します。ここでは、FontSize → 90、FontFamily → Symbol を設定 

     します。 

    ⑧ ランモードで実行します。   をクリックして下さい。 

      ラジオボタンの選択を変更すると、出力値がテキストラベルに反映することを確認して 

     下さい。 

 

   4.５.２．ラジオボタンのグループを設定する 

    ここでは、ラジオボタンのグループの設定方法を記載します。 

 

    ① Radio Button の Properties の Basic Properties → RadioGroup → グループ名 を 

     記入します。 

    ② 異なるグループを作成し、選択してみて下さい。グループごとにチェックできることを 

     確認して下さい。 

 

TextLabel1 

TextLabel２ 

RadioButton１ 

RadioButton２ 

RadioButton３ 
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  4.６．シンプルボタンとトグルボタンの使い方 

   ボタンコントロールには、２種類あります。 

   ボタンクリックイベントにスクリプトを記載して使用します。 

 

   4.６.1．Simple Button 

    Simple Buttonは、ボタンクリックイベントにスクリプトを記載して使用します。 

    「4.４.２．スクリプトで計算式を作成する方法』を参照して下さい。 

 

   4.６.２．Toggle Button 

    Toggle Buttonは、ノーマル時と押された時の状態を設定することが可能です。 

  さらに、各状態は文字、文字の色、ボタンの色と関連づけることが可能です。 

 

  4.７．Text Entry Fieldの使い方 

   データ入力に使用するテキストボックスです。 

   作成画面からテキスト文字または、数値の入力を可能にします。 

   ※デザインモードでは値の入力は不可です。ランモードにすることで、値の入力が可能になり 

    ます。 

 

  4.８．ハイパーリンク・コントロールの使い方 

   他のページや既存のURLへリンクを張ることが可能です。 

 コントロールとして、Hyperlink Button、Hyperlink Image、Hyperlink Text があります。 

 

   4.８.１．Hyperlink Button のプロパティ 

Property Name Value 説明 

Basic Properties Text  ボタンのラベル。 

PageUri  指定内部リンク先 

HttpUrl  指定外部リンク先 

UseHttpUrl ☑ ☑：HttpUrlを指定 

チェックなし：PageUriを指定 

URLForDisplay  表示されるリンクページの URL

が表示されます。 

UseHttpUrlに☑が入っていれ

ば、HttpUrlが表示されます。 

IsEnable ☑ ☑：コントロールが有効 
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  4.９．Image の使い方   

   Image は、イメージファイルに保存されている画像を表示します。 

   会社ロゴの表示やオリジナルの画像の表示に使用します。 

   また、カメラ機能で取得した画像を表示することも可能です。 

 

   4.９.１．オリジナル画像の表示方法 

     オリジナルのイメージをキャンパスに表示することが可能です。 

 

     ① 下記フォルダ内にオリジナルファイルを作成して保存します。 

     【64ビットCPUの場合】 

      C:\Program Files (x86)\Cogent\Cogent DataHub\Plugin\WebServer\html 

      \Silverlight\Images 

      【32ビットCPUの場合】 

       C:\Program Files\Cogent\Cogent DataHub\Plugin\WebServer\html\Silverlight 

          \Images 

       ※Cogent DataHubをインストールする際に保存先を変更しなかった場合 

     ② メニューバーの Tools → Diagnostics → Refresh Application Objects 

                                              をクリックして構成をリフレッシュして下さい。 

     ③ コントロール・アイコンから Image をクリックで選択します。 

     ④ Basic Properties の Image File → ImageURI のドロップダウンリストに先ほど保存 

     した画像が追加されますので、クリックで選択して下さい。 

          選択された画像が画面に表示されます。 

 

  4.1０．System Informationの使い方 

   System Information は、システムやページ情報にアクセスします。 

   情報には、ローカル時間やユーザ、ページ名等が含まれます。これらの情報をプロパティの値 

   として読み込むことが可能です。TextLabel などの別のコントロール・パーツのプロパティに 

   バインディングして使用します。 

   このコントロール・パーツは、デザインモードでは画面に表示されますが、実行モードでは非表 

   示となります。 

 

   4.1０.１．時間の表示方法 

    ローカルの時間を表示するには、System Information パーツを使用します。 

    ここでは SystemInformation のローカル時間を TextLabel に表示する方法を記載しま 

    す。 
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   System Information のプロパティ 

Property Name Value 説明 

System 

Information 

LocalTime 12/10/2015 

10:00:00 

ローカルの時間 

 

    ① コントロール・アイコンから TextLabel と System Information をクリックし画面に 

     準備します。 

    ② TextLabel を選択し、Basic Properties → Input Value で Binging：Simple を選択し 

     ます。 

 

 

 

 

 

 

 

 

 

    ③     をクリックし、キャンバス上の System Information パーツをクリックします。 

    ④  System Information のプロパティが表示されますので、 

       System Information → LocalTime を選択します。 

 

 

 

 

 

 

 

 

 

 

 

  

    ⑤  Text Label に時間が表示されます。 

 

  



Cogent DataHub® 入門ガイド 

   

S021601-001-120 2019/1/6   189  

DataHub WebView Scripting  

 

  WebView Scripting で使用する代表的な関数を紹介します。 

  詳細は http://www.cogentdatahub.com/WV_Docs/Scripting/index.html をご参照下さい。 

 

１．Special Function 

  １.１．VAL 

    データポイントの値を取得します。 

   （例）VAL(“DataPid:PID1.Pv”); 

    パラメータ ・データポイント名 （Type:String） 

    戻り値   ・データポイントの値（値は数字とテキスト） 

 

  1.２．GET 

    指定したデータポイントのObjectを取得します。 

   （例）GET(“DataPid:PID1.Pv”).Value; 

         ※Value以外にPointName、Quality、TimestampAsLocalTime 

   パラメータ ・データポイント名 Type:String 

    戻り値   ・データポイントの値、（ポイント名、品質、時間） 

 

  1.３．SET 

    指定したデータポイント（またはダイナミックなグローバル関数）の値をセットします。 

   （例）SET(“DataPid:PID1.Pv”,50 ); 

    パラメータ ・データポイント名 Type:String 

          ・データポイントの値 Type:Object（値は数字とテキスト） 

    

  1.４．GETP  

    参照プロパティの値を取得します。 

   （例）GETP(“ ComboBox1 @ SelectedValue ”); 

 

    パラメータ ・プロパティ参照先 Type:String 

    戻り値   ・プロパティの値 

 コントロール名     プロパティ名 

http://www.cogentdatahub.com/WV_Docs/Scripting/index.html
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  1.5．SETP 

    SETP：コントロール・パーツのプロパティの値を書き込みます。 

   （例）SETP(“ TextLabel1 @ Input ” , 50 ); 

 

    プロパティに設定する値が文字列の場合は、値を “ ” で囲みます。 

     SETP(“TextLabel1@Input”,”温度”); 

 

  プロパティ名の表示方法 

 

 DataHub WebView Scripting で使用するプロパティ名は、Properties の Name Column に 

 記載されています。 

 Properties Name Column の表示方法を記載します。 

 

  ① コントロール･パーツを選択します。（何でも結構です） 

  ② Properties の    をクリックし、プルダウンリストの Name Column にチェックを 

     入れます。 

   もしくは、メニューバーのTools → Options → Properties →  

     Show Name and Target Path columns に True をセットし、OKをクリックします。 

  ③ Properties のリストに Name が追加されます。これがプロパティ名になります。  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

          読み込みのみ 

プロパティに設定する値  コントロール名     プロパティ名 
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応用事例のご紹介 

 

Cogent DataHubには、お客様の応用ソフトウェアをCogent DataHubの機能として実装するための 

ソフトインターフェース（プラグイン）が準備されています。 

ここでは、このプラグインを使用した応用事例をご紹介します。 

 

 １．HEMS サーバ開発ツール （日新システムズ） 

   Cogent Real-Time Systems社 の Cogent DataHub にHEMS標準インターフェースである 

   「ECHONET Lite」のコントローラ機能を実装するプラグインです。 

    本ツールと DataHub WebView を連携することで、HEMS機器の状態監視・制御画面を作成 

   することができます。 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  [販売元] 株式会社日新システムズ http://www.co-nss.co.jp/ 

       http://www.co-nss.co.jp/products/middleware/enet-plugin.html 

  

http://www.co-nss.co.jp/
http://www.co-nss.co.jp/products/middleware/enet-plugin.html
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付録 

１．資料情報 

  Cogent DataHub® に関するリンク先をご紹介します。 

 

    Cogent Real-Time Systems社 ホームページ 

      https://cogentdatahub.com/ 

 

    Cogent DataHub マニュアル（英文） 

      https://cogentdatahub.com/library/documentation/ 

 

    Cogent DataHub ビデオマニュアル（英文） 

      https://cogentdatahub.com/library/videos/ 

DataHubビデオでは、コントロール・パーツの設定方法が多数掲載されています。 

        DataHub WebViewトレーニングビデオ 

        １．WebViewランモード概略説明（18：49） 

        ２．デザインモードの基礎（29：05） 

        ３．コントロールのプロパティバインディング（16：41） 

        ４．共通プロパティの操作（27：59） 

        ５．基本シンボルの動作説明（23：05） 

        ６．シンボル InputとStatesの設定（15：57） 

        ７．アドバンスコントロールの操作（18：54） 

 

    Cogent DataHub 日本語ビデオガイド      

https://cogentdatahub.com/media/Cogent-DataHub-Japan-video-guide.pdf 

 

DataHubビデオは英語ですが、ビデオマニュアル日本語解説書と一緒にご使用いただくことで

理解を深めていただくことが可能です。 

 

    Cogent DataHub 最新ソフトウェア ダウンロード ページ 

      https://cogentdatahub.com/download/ 

  

https://cogentdatahub.com/
https://cogentdatahub.com/library/documentation/
https://cogentdatahub.com/library/videos/
https://cogentdatahub.com/media/Cogent-DataHub-Japan-video-guide.pdf
https://cogentdatahub.com/download/
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本書ガイドに関するお問い合わせ先 

 

Cogent DataHub Application Center 

info@datahub-ac.com 

mailto:info@datahub-ac.com




 


